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Kapitel 1 • Allgemeines

1. Handbuchhistorie

Version Datum Kommentar

1.00 September 2006 Erste Version

Tabelle 1: Handbuchhistorie
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Allgemeines • Integration der B&R DeviceNet Bus Controller
2. Integration der B&R DeviceNet Bus Controller

Ziel dieses Getting Started Dokuments ist die Integration der B&R DeviceNet Bus Controller als
Slaves in beliebige DeviceNet Master Systeme. Hierzu zählt die Einbindung in eine Rockwell Au-
tomation Umgebung ebenso wie die beispielhafte Projektierung mit dem B&R Feldbus Konfigu-
rator.

Die Produktpalette der B&R DeviceNet Bus Controller umfasst Module aus dem X20 und X67
System. Alle B&R DeviceNet Bus Controller unterstützen den X2X Link. Die Kernidee hierbei ist,
die Backplane eines Racksystems zu dezentralisieren. Das Kabel ersetzt die Backplane, mit der
alle Module verbunden werden. Direkt aneinander gereihte X20, X67 und XV Module können in
Abständen von jeweils bis zu 100 m über Schaltschrankgrenzen hinweg positioniert werden.

Alle B&R DeviceNet Bus Controller lassen sich sowohl "linear" mittels des B&R Feldbuskonfigu-
rators als auch "modular" über die Bedienoberfläche der Rockwell Software projektieren.

2.1  X20 DeviceNet Bus Controller

Der X20 DeviceNet Bus Controller X20BC0053 ermöglicht die Kopplung von X2X Link I/O Kno-
ten an DeviceNet. Er verfügt über automatische Übertragungsratenerkennung und AutoMapping
der über X2X Link angeschlossenen I/O Module. Als Betriebsarten werden z . B.  Explicit Mes-
saging, Change of State, Cyclic, Polled und Bit Strobe unterstützt. Neben den Standardkommu-
nikationsobjekten gibt es noch eine Vielzahl von herstellerspezifischen Objekten. An den Bus
Controller können X20 oder andere Module die auf X2X Link basieren angehängt werden.

Eine ausführliche Beschreibung des X20BC0053 mit Angabe des notwendigen Zubehörs ist
dem entsprechenden Anwenderhandbuch zu entnehmen. Technische Details sind im zugehöri-
gen Datenblatt aufgelistet.

2.2  X67 DeviceNet Bus Controller

Der X67 DeviceNet Bus Controller X67BC5321(IP67 Ausführung) ermöglicht die Kopplung des
X2X I/O Systems an DeviceNet. Neben den schon beim X20 Bus Controller genannten Eigen-
schaften verfügt er zusätzlich über 8 Digitalkanäle, die wahlfrei als Ein- oder Ausgänge parame-
triert werden können. Ausführlichere Produkthinweise und Möglichkeiten der Parametrierung
können im zugehörigen Anwenderhandbuch oder Datenblatt nachgelesen werden.

Bestellnummer Kurzbeschreibung Abbildung

X20BC0053 X20 Bus Controller Feldbus Interface, 1 DeviceNet Schnittstelle, LEDs zur Statusanzeige

Tabelle 2: X20 DeviceNet Bus Controller
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Im Folgenden wird allgemein vom DeviceNet Bus Controller gesprochen und nur bei tatsächlich
vorhandenen Projektierungsunterschieden auf die verschiedenen Varianten eingegangen.

3. EDS-Datei

Voraussetzung für die erfolgreiche Integration der B&R DeviceNet Bus Controller in das jeweili-
ge Engineering Tool ist der Import der dazugehörigen EDS-Datei (Electronic Data Sheet). Diese
ist auf der B&R Homepage (www.br-automation.com) für alle oben aufgeführten Module verfüg-
bar. Mittels Angabe der Produkt- oder Seriennummer im Eingabefeld „Produkt Suche“ (jeweils
im rechten Bereich zu finden) erscheint die entsprechende Produktinformation. Im Download-
Bereich jedes Moduls befindet sich der Verweis auf das EDS-Paket. 
Vor dem Herunterladen besteht die Möglichkeit der Versionsauswahl. Beim erstmaligen Einbin-
den der DeviceNet Bus Controller in ein anderes Engineering Tool wird empfohlen die höchste
Version zu verwenden.

4. Unterschied lineare und modulare Projektierung

Der Unterschied zwischen der linearen und der modularen Projektierung besteht in der Anzahl
und dem Aufbau der benötigten EDS-Files.

4.1  Lineare Projektierung

Bei der linearen Projektierung, die z. B. beim B&R Feldbus Konfigurator Anwendung findet, ist-
nur eine einzelne EDS-Datei für jeden Bus Controller (X20/X67) erforderlich. Diese beinhaltet
alle Daten des Bus Controllers sowie die für am X2X-Link angeschlossenen I/O-Module.

4.2  Modulare Projektierung

Das modulare Prinzip, welches bei der Projektierung mit der Rockwell Software verwendet wird
setzt mehrere verschiedene EDS-Dateien voraus:

• 1 EDS-Datei für den Bus Controller

• 1 EDS-Datei für den lokalen Bus (X2X-Link) nach dem Bus Controller

• je eine EDS-Datei für jedes einzelne I/O-Modul am X2X-Link

Bestellnummer Kurzbeschreibung Abbildung

X67BC5321 X67 DeviceNet Buscontroller, X2X Link Versorgung 3 W, 8 Digitalkanäle wahlfrei als Ein- oder Aus-
gang parametrierbar, 24 VDC, 0,5 A, Eingangsfilter parametrierbar, LEDs zur Statusanzeige.

Tabelle 3: X67 DeviceNet Bus Controller
13DeviceNet Getting Started Anwenderhandbuch V 1.00
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Allgemeines • X20 Register Anwenderhandbuch
5. X20 Register Anwenderhandbuch

Um die B&R DeviceNet Bus Controller linear zu projektieren, wie dies z. B. beim B&R Feldbus
Konfigurator der Fall ist, ist es notwendig die genaue Registerbelegung eines jeden Moduls wel-
ches am X2X Link angschlossen ist zu kennen.
Bei einer modularen Projektierung mittels der Rockwell Software sind diese Informationen be-
reits in der EDS-Datei integriert und können vom Anwender unbeachtet bleiben.
Das X20 Register Anwenderhandbuch enthält zu allen am X2X Link unterstützen Modulen ne-
ben einer detaillierten Registerbeschreibung Informationen zu verschiedenen Kanaltypen, dem
B&R ID Code auch Angaben zu Funktionsmodellen und Zykluszeiten.
Entsprechende Informationen für die X67 Module befinden sich direkt in dessen Datenblätter,
welche über die Homepage verfügbar sind (www.br-automation.com).  

6. Berechnung der Ein- und Ausgangsdatenlängen

Neben der genauen Registerbelegung ist es für die DeviceNet Projektierung mit einem "linea-
ren" Engineering Tool (z. B. dem B&R Feldbuskonfigurator) wichtig, die genaue Länge der von
jedem einzelnem Modul konsumierten und produzierten Datenmengen zu kennen. Um einfach
und schnell diese Informationen zu erhalten, sind in Kapitel 4 und 5 Tabellen der Registerbele-
gungen sowie Berechnungsbeispiele zu den jeweiligen X20 und X67 Modulen beigefügt.
14 DeviceNet Getting Started Anwenderhandbuch V 1.00
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Kapitel 2 • Rockwell Software

1. Rockwell Softwarepakete

Für die Projektierung der B&R DeviceNet Bus Controller sind folgende Softwarepakete von
Rockwell Automation notwendig:

• RSLinx

• RSNetworx for DeviceNet

• RSLogix 5000

Die nachfolgende Beschreibung kann im Wesentlichen den Anwenderhandbüchern zu den ein-
zelnen Softwarepakten entnommen werden. Diese sind im Dokumentationsbereich unter der
Adresse http://literature.rockwellautomation.com frei erhältlich. Die abgebildeten Screenshots
wurden mit den verschiedenen Softwarepaketen erstellt.

1.1  RSLinx

Das Software Tool RSLinx entspricht in seiner Funktionsweise einem Schnittstellenkonfigurator,
der es ermöglicht die Software mit der physikalisch vorhandenen Steuerung zu verbinden. Dies
ist sowohl über eine serielle Verbindung als auch über eine TCP/IP Verknüpfung möglich. Eine
komfortable Variante zum Testen der vorgenommenen Einstellungen bietet die integrierte
Schnittstellendiagnose.

1.2  RSNetWorx for DeviceNet

Alle Hardwarekonfigurationen werden mit der Software RSNetWorx for DeviceNet erstellt. Die
am Feldbus angeschlossenen Teilnehmer lassen sich mit diesem Tool entsprechend positionie-
ren und parametrieren. Die Projektierung der B&R DeviceNet Bus Controller wird modular
durchgeführt und ist durch die Integration der zugehörigen EDS Files möglich.

1.3  RSLogix 5000

Die Verknüpfung der erstellten Hardwarekonfiguration mit der zugehörigen Projektsoftware wird
mit dem Programm RSLogix 5000 durchgeführt. Von hier aus lassen sich die B&R DeviceNet
Bus Controller ansteuern und der I/O-Datenverkehr initialisieren. 
15DeviceNet Getting Started Anwenderhandbuch V 1.00
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Rockwell Software • Hardware Voraussetzungen
2. Hardware Voraussetzungen

Für das hier angeführte Beispiel wurde folgende Hardware von Allen Bradley verwendet:

• 1769-L35 CompactLogix Controller

• 1769-PA2 Compact I/O Power Supply

• 1769-SDN CompactLogix DeviceNet Scanner

Ziel dieses Anwenderhandbuches ist es, allgemeine Unterstützung bei der Integration der B&R
DeviceNet Bus Controller zu leisten. Bei anderen physikalischen Gegebenheiten sollte dieses
Anwenderhandbuch zumindest als Referenz verwendet werden können und mit Hilfe des hier
beschriebenen Beispiels zum Ziel führen. Voraussetzung ist allerdings ein vorhandener Hard-
wareaufbau der sich an der Struktur DeviceNet Scanner (Master) und B&R DeviceNet Bus Con-
troller (Slave) orientiert. 

3. Installation der EDS-Datei

Um die B&R DeviceNet Bus Controller mittels der Rockwell Software anzusteuern ist es notwen-
dig die herstellerspezifschen EDS-Dateien (Electronic Data Sheets) zu installieren. Diese EDS-
Dateien beinhalten alle notwendigen Daten und Informationen um die Bus Controller und alle an-
deren Geräte welche über den X2X-Link angeschlossen werden zu projektieren.

Das Einbinden neuer EDS-Dateien ist über die RSNetWorx for DeviceNet Software möglich.
Wird diese geöffnet, befindet sich im Menüpfad unter Tools->EDS Wizard der Assistent für die
Integration. Mit ihm lassen sich bisherige EDS-Dateien deaktivieren, neue installieren, zugehö-
rige Bitmap-Dateien austauschen und EDS-Files für neue Geräte erstellen.

Abbildung 1: Menü im EDS-Wizard
16 DeviceNet Getting Started Anwenderhandbuch V 1.00
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Um die EDS-Dateien der B&R DeviceNet Bus Controller in die Datenbank der zur Verfügung ste-
henden Geräte einzubinden, muss die Option "Register an EDS file(s)" ausgewählt werden.
Es besteht anschließend die Möglichkeit einzelne oder mehrere EDS-Dateien aus einem Ord-
ner-Verzeichnis zu registrieren.

Nach Angabe des Pfades der zu installierenden EDS-Dateien und anklicken des Next-Buttons
erscheint ein Fenster mit einem kurzen Testbericht der zur Integration angegebenen Dateien.
Auftretende Warnhinweise (gelbes Warndreieck) bzgl. der Länge einiger Parameterangaben
können hierbei toleriert werden.

Abbildung 2: Auswahl der zu registrierenden EDS-Dateien

Abbildung 3: Ergebnis der EDS-Datei Überprüfung
17DeviceNet Getting Started Anwenderhandbuch V 1.00



Rockwell Software • Integration der B&R DeviceNet Bus Controller
Dem EDS-Installations Assistenten folgend werden alle im Zuge der Registerierung der EDS-
Dateien zugehörigen Bitmap-Dateien angezeigt. Es besteht die Möglichkeit derzeit vorhandene
Icons auszutauschen. Ein Überblick in Form einer Liste aller zu registrienden EDS-Dateien faßt
die gewünschte Auswahl zusammen. Abschließend werden die EDS-Dateien installiert und die
erfolgreiche Registrierung mit einer Meldung quittiert. Die B&R DeviceNet Bus Controller stehen
nach der Registrierung im Hardware-Katalog zur Verfügung.

4. Integration der B&R DeviceNet Bus Controller

4.1  Online Verbindung

Um auf die Steuerung online zugreifen zu können um z. B. erstellte Projekte und Konfigurationen
zu übertragen, ist es notwendig, dass die Schnittstelle zwischen der Steuerung und dem Pro-
grammiergerät (PC) konfiguriert ist. Die in diesem Beispiel verwendete Compact Logix L35E
CPU verfügt sowohl über eine serielle als auch über ein TCP/IP-Schnittstelle. Die Konfiguration
dieser beiden Schnittstellen kann mit Hilfe des Softwaretools RSLinx geschehen. Unter dem
Menüpunkt Communications->Configure Drivers können Schnittstellenparameter gesetzt und
Verbindungen konfiguriert werden. Falls der Steuerung keine bekannte IP-Adresse zugewiesen
ist, die bereits auf der CPU gespeichert ist, empfiehlt es sich zuerst seriell auf die Steuerung zu-
zugreifen. 

Abbildung 4: Parametrierung der seriellen Schnittstelle
18 DeviceNet Getting Started Anwenderhandbuch V 1.00
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Im sich öffnenden Fenster kann in der Sparte "Available Driver Types" mittels des Buttons "Add
New..." der Typ "RS-232 DF1 devices" für die serielle Verbindung ausgewählt werden. Für eine
Verbindung über die TCP/IP-Schnittstelle ist der Treiber Typ "Ethernet/IP Driver" auszuwählen.
Bei der Parametrierung der seriellen Schnittstelle kann der Anwender den COM-Port ebenso wie
die Baudrate auswählen. Sehr hilfreich ist die Verwendung des Buttons "Auto-Configure", der
die vorhandenen Verbindungsparameter abgleicht und eine gültige Kommunikationsschnittstelle
einrichtet. 
Bei Verwendung der TCP/IP-Schnittstelle muss die IP-Adresse der Steuerung, zu der eine Ver-
bindung aufgebaut werden soll, eingegeben werden. (1. Apply-> 2. OK). Zuweisungen der IP-
Adressen sind typischerweise mit dem BootP/DHCP Server möglich (Beschreibung hierzu im
Anwenderhandbuch der verwendeten Steuerung).

Sind die entsprechenden Schnittstellen parametriert, werden diese in der Liste der konfigurierten
Treiber Verbindungen mit Angabe des Status (z. B. "Running") aufgelistet. Ein automatischer
Netzwerkscan über die konfigurierten Schnittstellen ist über die Funktion "RSWho" in der RSLinx
Software integriert. Diese Funktion lässt sich entweder über das entsprechende Icon oder über
den Menüpunkt Communications->RSWho aufrufen. Sie bietet dem Anwender einen Überblick
der angschlossenen Hardware. Im nachfolgenden Screenshot besteht sowohl über die serielle
(AB_DF1-1, DF1) als auch über die TCP/IP-Schnittstelle (AB_ETHIP-1, Ethernet) eine Verbin-
dung zur Steuerung an die in diesem Beispiel der X20BC0053 Bus Controller angeschlossen ist.
Die Schnittstellenverbindung ist Voraussetzung für die anschließende Übertragung der Netz-
werkkonfiguration und die softwareseitige Projektierung mittels des Programms RSLogix 5000.
Unter dem Menüpunkt "Communications" ist unter anderem auch eine Treiber- und CIP-Diagno-
se möglich.

Abbildung 5: Parametrierung der TCP/IP Schnittstelle
19DeviceNet Getting Started Anwenderhandbuch V 1.00
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Nachfolgender Screenshot zeigt die Browsing-Struktur mittels der RSWho-Funktion.

Abbildung 6: Übersicht der konfigurierten Schnittstellen-Treiber

Abbildung 7: Browsing Funktion RSWho
20 DeviceNet Getting Started Anwenderhandbuch V 1.00
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4.2  Netzwerkkonfiguration

Die vollständige Netzwerkkonfiguration wird mittels der Software RSNetWorx for DeviceNet
durchgeführt. Nach Aufruf der Software öffnet sich automatisch das Konfigurationsfenster. Auf
der linken Seite sollte nach Registrierung der entsprechenden EDS-Dateien die B&R DeviceNet
Bus Controller in dem Ordner der herstellerspezifischen Produkte auftauchen. Für die Beispiel-
konfiguration wird als Master der 1768-SDN DeviceNet Scanner von Allen Bradley verwendet.
Als Slave wird der X20BC0053 Bus Controller gewählt. Ein Doppelklick auf die gewünschten Mo-
dule fügt diese auf der rechten Seite in das Netzwerk ein. 

Im X2X-Link des X20BC0053 ist neben dem notwendigen Einspeisemodul X20PS9400 das di-
gitale Ausgangsmodul X20DO8332 angeschlossen. Alle X2X-Link Module sind nicht im Hard-
warekatalog aufgelistet, da diese keine DeviceNet Kommunikation aufweisen. Sie sind in der
Konfiguration des Bus Controllers ersichtlich.

4.3  Busparameter

Die Baudrate kann unter dem Menüpunkt Tools->Node Commissioning eingestellt werden. Über
eine Browse-Funktion kann der betreffende Knotenpunkt ausgewählt werden. Das Feld "I want
to input the address for the device on the selected network" ist zu aktivieren und die Schnittstel-
lenverbindung zum gewünschten Gerät festzulegen. Hierbei ist darauf zu achten, dass auch bei
der Pfadangabe stets die zugehörige Knotennummer des Netzwerkteilnehmers anzugeben ist.
Zur Auswahl stehen die DeviceNet Baudraten 125, 250 und 500 kBit/s. 

Eine Übernahme der neu eingestellten Baudrate wird erst nach einem Neustart der CPU durch-
geführt.

Abbildung 8: Netzwerkkonfiguration
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Abbildung 9: Baudraten-Einstellung

Information:
Während die automatische Übertragungsratenerkennung läuft, sind beide Device-
Net LEDs ausgeschaltet (da es für diesen Zustand nach der DeviceNet Spezifikation
keine LED Statusdefinition gibt.

Um sicherzustellen, dass das Modul versorgt ist und gebootet hat, setzt diese her-
stellerspezifische Statusannahme voraus ...  

- dass die RUN LED des Einspeisemoduls (X20PS9400) des X20BC0053 aktiv ist

- dass eine der beiden Modul I/O Status LEDs des X67BC5321 aktiv ist.
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4.4  Parametrierung der B&R DeviceNet Bus Controller

Bei der Parametrierung sollte mit den angeschlossenen Slavemodulen (z. B. B&R DeviceNet
Bus Controller) begonnen und erst zum Schluss der Master konfiguriert werden. Es stehen dann
alle von den angeschlossenen Slaves benötigten Ein- und Ausgangsdatenlängen fest und kön-
nen dem Master zugewiesen werden.
Ein Doppelklick auf die grafische Darstellung des X20BC0053 öffnet mehrere Reiter zur Para-
metrierung. 

Beim X20BC0053 ergeben sich folgende Parametrierungsmöglichkeiten:

• General

Im Reiter "General" lässt sich ein Gerätename sowie die Knotennummer (MAC ID) einstellen. Es
ist zulässig einen Slave mehrmals auszuwählen. Jeder Slave muss jedoch zur Unterscheidung
im Netzwerk eine eigene (eindeutige) Stationsadresse besitzen.

Hinweis
Die angegebene Stationsadresse muss mit der am Bus Controller eingestellten Kno-
tennummer übereinstimmen

Abbildung 10: Knotennummern-Schalter X20BC0053

Abbildung 11: Knotennummern-Schalter X67BC5321

Information:
Sowohl X67 als auch X20 DeviceNet Bus Controller übernehmen die eingestellten
Knotennummern erst nach einem Neustart!
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• Module Configuration

Im Abschnitt "Module Configuration" können die für den X2X-Link vorgesehenen Module einge-
fügt werden. Alle Module die zur Auswahl stehen sind auf der linken Seite im Hardwarekatalog
aufgelistet. Dieser lässt sich nach dem Katalognamen und der Produktbeschreibung sortieren.
Für die hier angeführte Beispielkonfiguration wird das digitale Ausgangsmodul X20DO8332 aus-
gewählt

Es ist darauf zu achten, dass beim X20C0053 immer das Einspeisemodul X20PS9400 und beim
X67BC5321 immer das digitale Mischmodul X67DM1321 auf Slot 1 positioniert wird. 

Ein Doppelklick auf das X2X-Link Modul oder das Anklicken des Buttons "Properties" ermöglicht
die Parametrierung jedes einzelnen Moduls, inklusive des angeschlossenen Bus Controllers.
Nachfolgender Screenshot zeigt die Konfigurationsmöglichkeiten des Bus Controllers.
Im Reiter "General" befinden sich lesbare Informationen zum Bus Controller (Typ, Hersteller...). 

Abbildung 12: Parametrierung des X2X-Links am X20BC0053
24 DeviceNet Getting Started Anwenderhandbuch V 1.00



Rockwell Software • Integration der B&R DeviceNet Bus Controller

Ka
pi

te
l 2

R
oc

kw
el

l S
of

tw
ar

e

• I/O Summary

Im Reiter "I/O Summary" sind alle Ein- und Ausgangsdatenlängen zusammengefasst. Hierbei
werden die konsumierten und produzierten Datenlängen detailliert aufgelistet und dem dazuge-
hörigen Modul zugeordnet. Anhand dieser Aufstellung ist sofort ersichtlich wieviele In- und Out-
put Byte der Bus Controller inklusive aller am X2X-Link angschlossenen Module benötigt. Die
sich hier errechneten Datenlängen müssen mit denen im Master überein stimmen.

4.4.1  Parametrierung der einzelnen Slots

Es wird empfohlen bei jedem Modul am X2X-Link bewusst die Ein- und Ausgangsdaten zu set-
zen. Eine direkte Selektierung der notwendigen Daten reduziert die Datenmenge und ermöglicht
eine schnellere Datenübertragung. 

Bei der Parametrierung der einzelnen Slots, läßt sich neben jedem einzelnen Modul auch der
X20BC0053 selbst parametrieren. Er ist auf Slot 00 angeordnet. Abgebildeter Screenshot zeigt
einen Ausschnitt der Konfigurationsmöglichkeiten.

X20BC0053

Der zweite Abschnitt "Configuration Settings“ ermöglicht anwenderspezifische Einstellungen,
z. B. die Auswahl der X2X-Link Zykluszeit. Hierzu zählt auch das gewünschte Verhalten bei ei-
nem fehlenden Modul im X2X-Link oder die Handhabung der Situation wenn das projektierte
Modul nicht mit dem tatsächlich physikalischen Modul übereinstimmt. In der Sparte "EDS File"
lässt sich die zum Modul gehörende EDS-Datei öffnen.

Abbildung 13: Konfiguration des X20BC0053 - I/O Summary
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X20DO8332

Abgebildeter Screenshot der Parametrierung des X20DO8332 Moduls zeigt das Setzen dessen
Ausgangsbytes. Sollen hier die Ausgänge gesetzt werden, müssen hierfür Ausgangsbytes zur
Verfügung gestellt werden.

Der Reiter "Configurations Settings" listet eine Übersicht aller verwendeten Ein- und Ausgangs-
daten auf. Bei jeder Änderung der Module am X2X-Link und deren Parametrierung ändern sich
auch die Ein- und Ausgangsdaten. Deshalb müssen nach jeder vorgenommenen Änderung die
sich daraus neu ergebenden Werte übernommen ("Apply" Button) und bestätigt werden ("OK"
Button).

Abbildung 14: Parametrierung X20BC0053

Abbildung 15: Setzen der Ausgangs-Bytes
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4.5  Parametierung des DeviceNet Masters

Sind alle Slaves sowie die B&R DeviceNet Bus Controller mit den Modulen am X2X-Link para-
metriert muss im Anschluss daran der DeviceNet Master (hier 1769-SDN Scanner) darauf ab-
gestimmt werden. Ein Doppelklick auf den DeviceNet Master öffnet dessen Konfigrationsfenster. 

• General: 

Vergabe eines Gerätenamens, einer Beschreibung sowie der Zuweisung der Knotennummer.

• Module: 

Einstellungen der verwendeten Plattform, dem Slave Mode oder der erwarteten Datenpaketrate.
Sind keine anderen Werte gewünscht, können die vorgegebenen Eintragungen übernommen
werden.

• Scanlist: 

Die Scanlist beinhaltet alle Netzwerkteilnehmer die vom Master angesteuert und überwacht wer-
den. Sie ist nach jeder Änderung bei den Slavemodulen zu aktualisieren, indem die dem Master
zugeordneten Module aus der Scanlist entfert und anschließend erneut eingefügt werden. 

Erst durch diese Vorgehensweise und Übernahme der Daten durch den "Apply"-> "OK"- Button
wird dem Master die aktuelle Konfiguration (z. B. neue Input- und Output-Datenlängen) mitge-
teilt. 

Abbildung 16: Scanliste des DeviceNet Masters
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Die Auswahl der "Automap on Add" Funktion bildet automatisch den notwendigen Speicherbe-
darf im Master ab, wenn I/O-Module in die Scanliste neu aufgenommen werden. "Node Active"
aktiviert die I/O Kommunikation zu den markierten Modulen. 

Die Auswahlbox "Electronic Key" teilt dem Master mit, auf welche Kriterien (Gerätetyp, Herstel-
ler, Produktcode...) er die angeschlossenen Slaves überprüfen soll. Dies ist z. B. für die automa-
tische Netzwerk-Regeneration von Bedeutung.

Hinter der Bezeichnung "Edit I/O Parameters" ist es möglich das Übertragungsverfahren (Stro-
bed, Polled, Change of State/Cyclic) zwischen Master und Device auszuwählen. Typischerweise
wird hierbei das Polling-Übertragungsverfahren ausgewählt.

• Input /Output

In diesem Reiter werden die bei den Slavemodulen parametrierten Ein- und Ausgangsdaten
dem Speicherbereich des Masters zugewiesen. Diese Aufschlüsselung der Daten unter Angabe
der zugeordneten Bits ermöglicht später den gezielten Zugriff auf jeden einzelnen Slave. Die
Ein- und Ausgangsdaten sind hierbei linear, in ihrer physikalischen Reihenfolge angeordnet.
Auch diese Daten sollten nach jeden Änderungen in den Slaves aktualisiert werden.

Abbildung 17: Eingangsdaten im Master
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• ADR

Die "ADR - Automatic Device Replacement" Funktion setzt sich aus der Configuration Recovery
(CR) und der Auto Address Recovery (AAR) zusammen.

Sie ermöglicht eine Rekonfiguration des Netzwerkes, falls ein angeschlossenes Gerät ausfällt.
Mit Hilfe des angegebenen "Electronic Keys" vergleicht der Scanner ein Gerät wenn sich dieses
nach seinem Ausfall wieder am Bus zurück meldet. Stimmen die vom Gerät übermittelten Daten
mit dem elektronisch hinterlegten Fingerabdruck überein, wird dem Gerät die entsprechende
Knotennummer zugewiesen und die notwendigen Daten übermittelt. Nähere Informationen und
Parametrierungshinweise finden sich in der Online Hile der RSNetworx for DeviceNet Software.
Die Gerätedaten können mit dem Button "Load Device Config" geladen werden. Dies ist Voraus-
setzung für die Aktivierung der "Configuration-" und "Auto-Address-" Recovery.
Es wird empfohlen sowohl "Configuration Recovery" als auch "Auto-Address Recovery" zu akti-
vieren. Fällt z. B. der Bus Controller aus, werden die Konfigurationsdaten erneut übertragen.

Eine Übertragung mittels der beiden Buttons "Upload from Scanner/Download to Scanner" ist
erst bei einer hergestellten Online-Verbindung möglich.

• Summary

Einen Überblick aller konfigurierten Netzwerkteilnehmer bietet der "Summary"-Reiter.

Abbildung 18: ADR-Einstellungen
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4.6  Download der erstellten Konfiguration

Über den Menüpfad Network->Online, kann die zuvor über RSLinx konfigurierte Schnittstelle
ausgewählt und für die aktuelle Projektierung aktiviert werden. Dies ist ebenfalls durch einen
Doppelklick auf das Netzwerk (schwarze dünne Linie) selbst möglich, wenn der aktuelle Verbin-
dungsstatus "Offline" ist.

Nach Auswahl des entsprechenden Ports über den ein Onlinezugriff möglich ist (OK-Button ak-
tiv) weist die Software mit einem Popup-Fenster darauf hin, dass eine Online Verbindung einen
Up- oder Download der erstellten Konfiguration voraussetzt. 

Die Bestätigung dieses Hinweises löst ein automatisches Scannen des angeschlossenen Netz-
werkes aus. Alle Netzwerkknotenadressen (0-63) werden versucht im Netzwerk aufzufinden.
Stimmt die Projektierung nicht mit dem tatsächlichen physikalischen Aufbau überein, wird eine
entsprechende Fehlermeldung ausgegeben. Der Scanvorgang läuft immer vollständig bis zur
Knotennummer 63 durch. Ist bereits bekannt, dass nur Knotennummern bis zu einer gewissen
Höhe vergeben sind, kann der Scanvorgang bedenkenlos abgebrochen werden, nachdem diese
Ziffer überschritten wurde.

Wurden die angeschlossenen Knoten gescannt, kann die erstellte Konfiguration über den Menü-
punkt Network->Download to Network auf die Steuerung übertragen werden.

Ebenso ist es jetzt im Status "Online Verbindung aufgebaut" möglich, die ADR-Konfiguration di-
rekt auf den Scanner über den Button "Download to Scanner" zu laden.

Abbildung 19: Aktivierung der Schnittstelle
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Die am Scanner vorhandene Address/Error-Anzeige gibt Auskunft über den aktuellen Zustand
der Projektierung. Die Anzeige wechselt hierbei zwischen der Fehlernummer und der Stations-
adresse die diesen Fehler produziert hat. 

Auflistungen der Fehlernummern befinden sich in den Datenblättern der entsprechenden De-
viceNet Master Geräten. Jede Fehlernummer steht hier einer kurzen Beschreibung und Lö-
sungsvorschlägen gegenüber.

Ist keine softwareseitige Projektierung vorhanden, sollte sich der DeviceNet Master nach Über-
tragen der Netzwerkstruktur selbst im "Idle" Modus und die angeschlossenen Feldbusteilnehmer
in einem fehlerfreien Zustand befinden.

4.7  Online-Diagnose

Mit dem Softwaretool RSNetWorx for DeviceNet ist es möglich eine einfache Diagnose der am
Netzwerk angeschlossenen Teilnehmer durchzuführen. Bei bestehender Online-Verbindung ist
hierzu das Konfigurationsfenster z. B. des Bus Controllers zu öffnen. Nach Auswahl des ge-
wünschten Moduls im Reiter "I/O Summary" kann über den Button "Monitor" das Watch-Fenster
aufgerufen werden. Wurde z. B. der Bus Controller selbst ausgewählt, so lassen sich über "Mo-
nitor" dessen Parameterwerte einsehen.

 

Abbildung 20: Monitor Funktion
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5. Projektierung mit RSLogix 5000

Die Projektierung mit dem Softwaretool RSLogix 5000 setzt eine funktionierende Schnittstellen-
kommunikation sowie die Konfiguration des Netzwerkes voraus.

5.1  Auswahl des Controllers und der Online Verbindung

Der Aufruf der Software öffnet die Arbeitsoberfläche. Das Anlegen eines neuen Projekts ge-
schieht über den Menüpfad File->New. 

Es besteht die Möglichkeit den gewünschten Controller (hier CompactLogix L35 Controller) aus-
zuwählen und einen Namen sowie eine kurze Beschreibung zu speichern. Sind mehrere Revi-
sionen vorhanden, so kann zwischen diesen gewählt und schließlich dem Controller zugeordnet
werden. Das somit neu angelegte Projekt wird im unten stehenden Projektpfad abgelegt. 

Ist der Controller ausgewählt wird automatisch das neue Projekt angelegt. 

Für das hier erläuterte Beispiel wird z. B. der 1769 DeviceNet Scanner unter der Kategorie Com-
munications ausgewählt.

Abbildung 21: Auswahl des CompactLogix Controller
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Durch rechten Mausklick auf den "CompactBus Local" kann dieser konfiguriert werden.  

Abbildung 22: Konfiguration CompactBus Local

Abbildung 23: RSLogix Projektfenster
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Im nächsten Schritt muss die Online-Verbindung konfiguriert werden. Hierzu befindet sich in der
Kopfleiste des Projektfensters die Pfadangabe (siehe Markierung). Sind bereits Schnittstellen
konfiguriert können diese durch Klicken auf den "RSWho" Button ausgewählt werden.

Im abgebildeten Beispiel wurde ein Zugang über die serielle Schnittstelle gewählt. Ein Klick auf
das Drop Down Menü in der Pfadleiste listet alle bisherigen verwendeten Schnisttstellen auf.

Im linken Teil der Kopfleiste befindet sich ein grafischer Schalter um die Steuerung zwischen den
verschieden Betriebsmodis umzuschalten. Es empfiehlt sich hardwareseitig an der Steuerung
die Wahl auf die "REM"-Eigenschaft einzustellen. Dies ermöglicht der Software eine flexible Um-
schaltung zwischen "RUN" und "PROG". Befindet sich der Schalter an der Steuerung auf "REM"
ist es nun möglich mit der Software für die weitere Programmierung auf "PROG" einzustellen
("REM Prog"). Die linke Spalte im Projektfenster gibt einen Überblick der bisher angelegten
Tasks, der I/O Projektierung und des verwendeten Controllers. Das Ausgabefenster ist in der
Fußzeile angesiedelt.

5.2  Zuordnung der Hardwarekonfiguration

Die zuvor erstellte Hardwarekonfiguration muss dem aktuellen Projekt zugeordnet werden. Mit-
tels rechter Maustauste auf den DeviceNet Scanner (1769-SDN/A DeviceNet Master) und Aus-
wahl des Punktes "Properties" öffnet sich das zugehörige Konfigurationsfenster. Dem Master
kann hier mitgeteilt werden, welche Netzwerkteilnehmer er über diesen Scanner zu erwarten
hat. Im Reiter "General" sind Einstellungen zum Namen, einer Beschreibung und der Art des
Electronic Keying möglich, hierbei kann Compatible Keying als Default-Einstellung  übernom-
men werden. Ebenso ist es nicht notwendig die bereits eingetragenen Einstellungen im Reiter
"Connections" zu verändern.  Der Reiter "RSNetWorx" ermöglicht über die Browse-Funktion
eine Hardwarezuordnung für das aktuelle Projekt zu hinterlegen. Ist eine solche Netzwerkkonfi-
guration ausgewählt und mit "Apply" bestätigt, kann auf sie direkt über den RSNetWorx-Button
zugegriffen werden. 

Wird die Hardwarekonfiguration gespeichert macht die Software darauf aufmerksam, dass die
Änderung nicht absehbare Auswirkungen haben kann, falls z. B. bereits Ausgänge im Projekt
angesteuert werden. Deshalb nur bewusstes Ändern der Hardware-Zuordnung.

Abbildung 24: Hardware-Verknüpfung
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5.3  Erstellung eines Tasks

Generell ist der Ablauf aller einzelner Tasks, der Main Routine, über einen Kontaktplan organi-
siert. Er ist in der linken Strukturübersicht abgelegt: Tasks->Main Task->Main Programm->Main
Routine

Alle erstellen Routinen können hier eingefügt und in Abhängigkeit zu anderen gestellt werden.
Unser Beispiel soll sich auf das Setzen der Ausgänge der am X20BC0053 angehängten
X20DO8332 beschränken. Hierzu muss ein neuer Task angelegt werden. 

Ein rechter Mausklick auf den Ordner "MainProgram" und anschließende Auswahl des Punktes
"New Routine" öffnet das Konfigurationsfenster für den neuen Task.

Hier kann dem Task ein Name, eine Beschreibung sowie der Typ zugeordnet werden. Als Pro-
grammiersprachen werden Strukturierter Text, Kontakt-, Funktionsplan und Ablaufsprache an-
geboten. Nach Festlegung der Eigenschaften öffnet sich ein Arbeitsblatt indem der Task
projektiert werden kann. Der neu angelegte Task befindet sich im Projektordner und ist dem
"Main Program" zugeordnet.  

Um den Inhalt editieren zu können, muss dass Arbeitsblatt durch einen Klick auf den Zeichenstift
aktiviert werden. Mittels rechtem Mausklick auf die leere Arbeitsfläche ist es möglich eine neue
Variable "New Tag" anzulegen. Ihr läßt sich ein Variablenname, eine kurze Beschreibung, der
Variablentyp, der Datentyp (BOOL, DINT...) und das Zahlenformat (Binär, Dezimal...) zuweisen.

Abbildung 25: Anlegen eines neuen Tasks
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Beim aktivieren der rechten Maustaste->Browse Tag stehen alle Controller Variablen zur Aus-
wahl. Hierzu zählen Systemvariablen, die für die Steuerung des Master (RUN, STOP...) als auch
die vorher bei der Konfiguration des Netzwerkers mit der RSNetWorx konfigurierten Ein- und
Ausgangsdatenlängen des Bus Controllers.

Abbildung 26: Anlegen einer neuen Variablen

Abbildung 27: Verwendung einer Controller Variablen
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Eine Übersicht aller vom Anwender angelegten Variablen, sowie der Controller Variablen befin-
det sich im linken Projektfenster im Bereich der "Controller Tags" sowie "Program Tags". Hier
können bereits angelegte Variablen geändert oder neue angelegt werden. Bei beiden Variablen-
Auflistungen wird zwischen der Monitor und Edit-Ansicht unterschieden. Die Monitor Ansicht bie-
tet sich z. B. zum Testen der Ein- und Ausgänge an.

Als kurze Beispielprojektierung wird im unten stehenden Programm die CPU in den "RUN"-Mo-
dus versetzt (Local:1:0.CommandRegister.Run := 1), eine Variable hochgezählt und den Aus-
gängen der X20DO8332 (Local:1:0.Data[0]) zugewiesen. Nach Eingabe des Sourcecodes ist es
notwendig die grünen OK-Button zu verwenden um den Compiliervorgang auszulösen und die
vorgenommene Editierung in den Programmablauf einzubinden.

Im unteren Ausgabefenster kann der Übersetzungsvorgang anhand von ausgegebenen Fehler-
meldungen überwacht werden. 

Abbildung 28: Monitor Controller Tags

Abbildung 29: OK-Button

Abbildung 30: Beispiel Programm
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Der so erstellte eigenständige Task muss nun im Kontaktplan des "Main"-Programms eingefügt
werden, z. B. über die Funktion "JSR" (Jump to Subroutine). Wird der Task nicht in das Haupt-
progamm integriert, wird er nicht ausgeführt. 
Wie schon bereits bei der Task-Erstellung steht dem Anwender auch im Kontaktplan des "Main"-
Programms eine umfangreiche Funktionsbibliothek zur Auswahl. Entsprechende Drop-Down-
Menüs erleichtern die Auswahl der einzubindenden Tasks oder Variablen.

Wichtig ist auch hier, dass nach dem Editiervorgang der grüne OK-Button (Accept all pending
edits in the program") gedrückt wird, ansonsten wird eine Fehlermeldung ausgegeben, dass die
aktuellen Änderungen nicht übernommen wurden.

Erläuterungen zu den verwendeten Symbolen finden sich in der RS Logix 5000 Online Hilfe, wel-
che sich auf schnellem Weg über die F1-Taste öffnen lässt.

Explizit Messaging

Mit dem MSG-Funktionsbaustein ist es möglich per "Explizit Messaging" asynchron auf Daten-
register zuzugreifen, z. B. asynchrone X2X-Link Register, oder z. B. das Setzen der Parameter
"Erase Flash" und "Save Parameter".

Abbildung 31: MainRoutine

Abbildung 32: MSG-Funktionsbaustein
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Im Konfigurationsfenster der MSG-Funktion können verschiedene "Service oder Message Ty-
pes" ausgewählt werden. Die "Destination" Adresse ist über die Browse-Funktionalität zu selek-
tieren.

5.4  Download des Projekts auf die Steuerung

Ist der Betriebsschalter an der Steuerung auf "REM" eingestellt, kann das erstellte Projekt über
die Software gestartet werden. Vom Status "Offline" (eingestellt durch die Software) kann ein
Download des Projektes auf die Steuerung durchgeführt werden. 

Wird daraufhin in die Betriebsart "Run" ("Go Online" -> "Run") umgeschaltet, sollten in dem hier
angeführten Beispielprojekt die Ausgänge der X20DO8332 angesteuert werden. Die Ausgangs-
LEDs an der X20DO8332 sollten nun aufleuchten.

Abbildung 33: Explicit Messaging - Konfigurationsfenster

Abbildung 34: Softwareseitiger Betriebsarten-Schalter
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Kapitel 3 • B&R Feldbus Konfigurator

1. Einleitung

Der B&R Feldbus Konfigurator ermöglicht eine einheitliche Konfiguration für die bekanntesten
Feldbussysteme wie z. B. Profibus, CANopen und DeviceNet. Als Basis für die Konfiguration der
unterschiedlichen Busteilnehmer werden standardisierte Konfigurationsdateien (GSD-, EDS-
Dateien) verwendet. Mittels eines grafischen Editors kann der Bus und die zugehörigen Teilneh-
mer konfiguriert werden.
Zudem lassen sich mit dem B&R Feldbus Konfigurator BR-Dateien (mit der Endung ".br") erzeu-
gen. Diese sind zur Projektierung der Teilnehmer mit dem Automation Studio notwendig und be-
inhalten die komplette Konfiguration des Feldbus-Netzwerkes.

Für die Projektierung der B&R DeviceNet Bus Controller sind Angaben zu den verwendeten Ein-
und Ausgangs-Datenlängen der einzelnen Module notwendig. Eine Übersicht der jeweiligen ver-
wendeten Ein- und Ausgangslängen befindet sich für X20-Module im Kapitel 4 und für X67-Mo-
dule im Kapitel 5 dieses Anwenderhandbuches.

2. Installation der EDS-Datei

Der B&R Feldbus Konfigurator liest beim Progammstart automatisch alle EDS-Dateien ein, die
in seinem EDS-Verzeichnis abgelegt sind. Dabei werden die Gerätenamen in eine interne Liste
aufgenommen. Die gerätespezifischen Daten werden während der Konfiguration direkt aus der
EDS-Datei ausgelesen.
Wird ein DeviceNet Gerät benötigt, welches noch nicht in der Auswahlliste erscheint, muss es
nachträglich eingebunden werden. Dies kann auf zwei Wegen geschehen. Entweder über die
Bedienoberfläche selbst oder in der Ordnerstruktur des B&R Feldbus Konfigurators.

2.1  Bedienoberfläche

Im Menpünkt File->Copy EDS lassen sich neue EDS-Dateien einbinden. Im sich öffnenden
Fenster kann der Quellpfad der gewünschten EDS-Datei (".eds") angegeben werden. Eine Ko-
pie der ausgewählten Datei wird im EDS-Ordner des B&R Feldbus Konfigurators für DeviceNet
abgelegt. Es ist darauf zu achten, dass die einzubindenden Dateien über keinen Schreibschutz
verfügen. Neben der EDS-Datei wird die zur Anzeige der Module im Konfigurator benötigten
Grafikdatei importiert. Eine erfolgreiche Kopie der EDS-Datei mit der zugehörigen Bitmap-Datei
wird mit einer Meldung quittiert.
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2.2  Ordnerstruktur

Alle im Konfigurator eingebundenen EDS-Dateien für DeviceNet sind in einem Ordner abgelegt.
Dieser befindet sich im Pfad: BrAutomationTool/BRFBCfg/Fieldbus/DevNet/EDS. Neu einzufü-
gende EDS-Dateien können in diesen Ordner hinzugefügt werden. Voraussetzung für eine feh-
lerfreie Einbindung ist das Datei-Format ".eds". 

Der in der Struktur des B&R Automation Tools abgelegte EDS-Ordner lässt sich beliebig ver-
schieben. Auch das Anlegen eines neuen Ordners ist erlaubt.

Hierbei ist darauf zu achten, dass der B&R Feldbus Konfigurator nur einen Ordner als Referenz-
quelle für die elektronischen Datenblätter (EDS-Dateien) verwendet. Alle benötigten EDS-Datei-
en sollten deshalb in diesem Ordner hinterlegt sein.
Der Pfad für den EDS-Ordner lässt sich im Menü unter: Settings->Path einstellen.

Im Feld "EDS File Directory" kann der Pfad für den Ordner mit den EDS-Dateien angegeben
werden. Ebenfalls einstellbar ist die "Project File Directory". Die hier eingestellten Werte können,
falls nicht anders gewünscht, übernommen werden. Damit der Konfigurator die neu hinzugefüg-
ten Dateien einliest, ist es notwendig die Software erneut zu starten.

3. Erstellen einer DeviceNet Konfiguration

Zum Erstellen einer neuen Konfiguration ist im Menü File->New zu wählen. In einer Liste werden
alle installierten Feldbussysteme angezeigt. Für das hier angeführte Beispiel ist "DeviceNet" als
Feldbus auszuwählen. Der Name des neu angelegten Projekts kann beim Beenden oder mit der
Funktion File->Save As gespeichert werden.

Abbildung 35: EDS-Ordner

Abbildung 36: Pfad der EDS-Dateien
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3.1  Einfügen eines Masters

Das Einfügen eines Masters geschieht mit dem Menüpunkt Insert->Master. Dies ist ebenfalls
über ein entsprechendes Icon möglich. Es öffnet sich ein Auswahlfenster, indem alle zur Verfü-
gung stehenden Master auf der linken Seite aufgelistet werden. Bereits hier ergibt sich die Mög-
lichkeit dem Master eine Stationsadresse sowie eine symbolische Beschreibung zuzuweisen.
Änderungen diesbezüglich können jederzeit nachträglich in der Master spezifischen Konfigura-
tion durchgeführt werden.

Beispielhaft wird als DeviceNet Master das Modul 3EX450.77-1 ausgewählt.

Nach Auswahl des Masters (3EX450.77-1) sieht die bisherige Konfiguration wie folgt aus:

3.1.1  Masterkonfiguration

Durch Setzen des Fokus auf den Master und Auswahl des Menüpunktes Settings->Master Set-
tings, einem Doppelklick auf den Master oder über das Menü der rechten Maustaste öffnet sich
das Master Konfigurationsfenster. Nach Möglichkeit der Zuweisung des Namens und der Stati-
onsadresse (MAC ID) können verschiedene Einstellungen vorgenommen werden.

• Anlaufverhalten nach Systeminitialisierung

Ist "Automatic release of the communication by the device" eingestellt, startet das Mastergerät
mit dem Datenaustausch am Bus direkt nachdem die Initialisierung beendet wurde. Bei Auswahl
"Controlled release of the communication by the application program" wird der Datenaustausch
am Bus vom Anwenderprogramm aus initialsiert. Diese Variante garantiert, dass keine unge-

Abbildung 37: Masterauswahl

Abbildung 38: Auswahl des DeviceNet Masters 3EX450.77-1
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wollten Zustände an den Ausgängen anliegen, da das Anwenderprogramm die vollständige
Kontrolle über den I/O-Daten Verkehr hat. Dies setzt jedoch eine gezielte Ansteuerung der Mo-
dule vom Anwenderprogramm voraus. Eine beispielhafte Projektierung wird im Anschluss auf
Basis des Automation Studios durchgeführt.

• Anwenderprogrammüberwachung

• Adressierungsmode

• Speicherformat (Wort-Module)

• Hardwareparameter

• Übergabeverfahren der Prozessdaten

Auswahl des Übergabeverfahrens der Prozessdaten zwischen der Applikation und dem Master.
Die Wahl welche Vorgehensweise verwendet wird, ist wichtig für den korrekten Datenaustausch
zwischen dem Anwendungsprogramm und dem Gerät. Das eingestellte Übergabeverfahren der
Prozessdaten (Handshake) muss vom Anwendungsprogramm unterstützt werden. 
Dies ist z. B. beim "buffered, host controlled", sowie beim "bus synchronous, host controlled"
Übergabeverfahren der Fall. Die Auswahl "no consistence, uncontrolled" eignet sich nur für
schnelle, einfache Diagnosezwecke.

Für das in diesem Anwenderhandbuch angeführte Beispiel sind die Einstellungen für den Master
identisch zu denen im abgebildeten Screenshot einzutragen.

Abbildung 39: Mastereinstellungen
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3.2  Busparameter

Unter dem Menüpunkt Settings->Bus Parameter kann die gewünschte Baudrate (125 kBit/s,
250 kBit/s, 500 kBit/s) eingestellt werden. Sowohl der X20BC0053 als auch der X67BC5321 ver-
fügen über eine automatische Baudratenerkennung und unterstützen alle zur Auswahl stehen-
den Baudraten.

3.3  Einfügen eines Slaves

Das Einfügen eines DeviceNet Slaves in die Konfiguration ist mit dem Menüpfad Insert->Slave
ebenso wie mit dem dazugehörigen Icon möglich. In der linken Liste werden alle Slave Geräte
zur Auswahl angezeigt, deren EDS-Dateien im EDS Verzeichnis abgelegt sind. Ein Filter kann
verwendet werden, um die Auswahlliste durch den angegebenen Slavetyp (z. B. I/O-Slave,
PLC...) und Hersteller (Vendor) einzuschränken. Weitere Informationen zu den einzelnen Slaves
werden unterhalb der Auswahlliste "Available slaves" angezeigt, wenn diese ausgewählt sind.
Mit einem Doppelklick oder mit der Hinzufügen "Add" Schaltfläche erscheint der Slave in der
rechten Liste. Alle Geräte in der rechten Liste werden dem aktuellen Master zugeordnet, der
rechts oben im Fenster angezeigt wird.

Abbildung 40: Auswahl der Baudrate

Information:
Während die automatische Übertragungsratenerkennung läuft, sind beide Device-
Net LEDs ausgeschaltet (da es für diesen Zustand nach der DeviceNet Spezifikation
keine LED Statusdefinition gibt.

Um sicherzustellen, das das Modul versorgt ist und gebootet hat, setzt diese her-
stellerspezifische Statusannahme voraus ...  

- dass die RUN LED des Einspeisemoduls (X20PS9400) des X20BC0053 aktiv ist

- dass eine der beiden Modul I/O Status LEDs des X67BC5321 aktiv ist.
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Mit jedem neu in der rechten Liste aufgenommenen Slave wird die Stationsadresse (MAC ID)
automatisch um eins erhöht. Eine Änderung der Stationsadresse und der Slave Bezeichnung ist
zu jeder Zeit im Slave Konfigurationsfenster möglich.

Hinweis: Es ist zulässig einen Slave mehrmals auszuwählen. Jeder Slave muss jedoch zur Un-
terscheidung im Netzwerk eine eigene (eindeutige) Stationsadresse besitzen. Die angegebene
Stationsadresse muss mit der am Bus Controller eingestellten Knotennummer übereinstimmen!

Abbildung 41: Fenster zur Slave Auswahl

Information:
Sowohl X67 als auch X20 DeviceNet Bus Controller übernehmen die eingestellten
Knotennummern erst nach einem Neustart!

Abbildung 42: Knotennummern-Schalter X20BC0053

Abbildung 43: Knotennummern-Schalter X67BC5321
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Für die Beispielkonfiguration wird als Slave der DeviceNet Bus Controller X67BC5321 ausge-
wählt. Er verbindet das DeviceNet Netzwerk mit dem X2X Link.

3.3.1  Slavekonfiguration

Das Slavekonfigurationsfenster öffnet sich mit einem Doppelklick auf den gewünschten Slave
oder über den Menüpunkt Settings->Slave Configuration (wenn dieser zuvor über den Fokus
ausgewählt wurde). In diesem Fenster werden die Module und deren Adressen dem Prozeßab-
bildspeicher im Master zugeordnet. 

Wichtig: Die angegebenen Adressen müssen mit denen der PC Anwendung übereinstimmen!

MAC-ID / Namensgebung / Aktivierung

Bei den allgemeinen Einstellungen der Slave Konfiguration lassen sich die MAC-ID sowie eine
Slave-Beschreibung eintragen. Eine gültige MAC-ID Adresse ist innerhalb des Bereiches von
0 bis 63. Je nach Auswahl des Feldes "Activate device in actual configuration" kann der Slave
in der aktuellen Feldbus Konfiguration aktiviert oder deaktiviert werden. Bei einer Deaktivierung
wird im Master für diesen Slave Prozessspeicher belegt, es findet jedoch kein Datenaustausch
vom Master zum Slave statt. Ein deaktivierter Slave wird in der grafischen Ansicht optisch aus-
gestrichen. 

Verbindungseigenschaften

Ein Gerät (Slave) im DeviceNet wird als Ansammlung von Objekten abgebildet. Diese Objekte
kommunizieren über unterschiedliche Verbindungsarten, welche in der Auswahl "aktuell gewähl-
te E/A Verbindung" eingestellt werden kann.

B&R DeviceNet Bus Controller unterstützen alle genannten Verbindungsarten. In vorliegender
Beschreibung wird jedoch nur auf das meist verwendete Polling Verbindungsverfahren einge-
gangen.

• Poll 

In dieser Verbindungsart sendet das Master Gerät in einem Pollbefehl Ausgangsdaten an das
Slave Gerät, welches diese Daten empfängt (konsumiert). Liegen dem Slave Gerät Daten für
diese Polling Verbindung vor, so sendet (produziert) es Daten zum Master zurück. Bevor eine
E/A Verbindung durch den Master initialisiert wird, liest dieser die konsumierte und produzierte

Abbildung 44: Master-Slave Beispielkonfiguration
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Verbindungsgröße der Daten aus dem Slave Gerät aus und vergleicht diese Werte mit den im
Master durch die Konfiguration angegebenen Werten. Nur wenn die beiden Werte übereinstim-
men, kann eine Verbindung aufgebaut werden. Ein Pollbefehl kann jederzeit vom Master an ein
angeschlossenes Gerät gesendet werden. Das Gerät muss auf einen Pollbefehl reagieren,
selbst wenn es keine zu versendenden Daten hat. Werden viele Geräte gleichzeitig durch das
Pollingverfahrens angesprochen kann eine hohe Netzlast enstehen. Häufig werden wiederholt
Daten übertragen, welche sich seit dem letzten Sendevorgang nicht geändert haben. Eine hö-
here Buslast hat den Nachteil, dass die Wahrscheinlichkeit für Kommunikationsfehler durch ex-
terne Einflüsse wächst.

• Bit Strobe

Bit Strobe Verbindungen erlauben das schnelle Versenden von geringen Mengen von Ein-/Aus-
gabe Daten zwischen dem Master und einem oder mehreren Geräten. Eine Bit Strobe Nachricht
enthält eine Bitkette von 64 Bit Ausgabedaten, was einem Output Bit pro möglichem Gerät ent-
spricht. Jedes Bit wird einer Geräteadresse im Netz zugewiesen. Hiermit hat dieser Service
Broadcast Funktionalität, was bedeutet, dass mehr als ein Gerät durch den Befehl angespro-
chen werden kann. Durch die gleichzeitige Ansprache mehrerer Geräte hat diese Verbindungs-
art Broadcast Funktionalität. Ein Gerät, das nur ein Bit verarbeitet (z. B. eine LED) kann dieses
Bit z. B. auch als Information benutzen, um einen bestimmten Zustand anzunehmen (an oder
aus). Andere Geräte können das Bit als Auslöser benutzen Daten an den Master über eine Poll
E/A Verbindung zurückzuschicken. Die Daten, die von jedem Gerät nach einem Bit Strobe Be-
fehl zurückgeschickt werden können, sind in der Länge auf 8 Bytes beschränkt. Folglich verur-
sacht Bit strobe weniger Buslast als Polling. 

Abbildung 45: Slave Konfigurationsfenster X67BC5321
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• Change of State / Cyclic

Bei dieser Verbindungsart schickt der Master eine beliebige Menge von Daten zum Zielgerät.
Diese Datenproduktion wird entweder durch einen erkannten geänderten Wert (Trigger) oder ei-
nen zyklischen Timer-Ablauf gestartet. Das Gerät kann in Abhängigkeit seiner Konfiguration
eine Bestätigungsmeldung zurückschicken, die eine beliebige Menge von Daten und/oder Sta-
tusangaben enthält. Eine Chance of State/Cyclic-Nachricht vom Gerät an den Master enthält
eine beliebige Menge an Daten. Diese Nachricht wird generiert wenn sich entweder Daten im
Gerät geändert haben oder der zyklische Timer abgelaufen ist. Der Master selbst kann diese
Meldung z. B. mit Ausgabedaten bestätigen. Eine Datenproduktion nur über change of state/cy-
clic hält die Buslast niedrig, während Daten von jedem Gerät so schnell wie möglich übermittelt
werden können.

UCMM Check

Die Funktion des UCMM (Unconnected Message Manager) wird von B&R DeviceNet Bus Con-
trollern nicht untertstützt. 

Sendesperrzeit / Expected Packet Rate

Die Sendesperrzeit konfiguriert die minimale Verzögerungszeit zwischen neuer Datenprodukti-
on in Vielfachen einer Millisekunde. Der Timer wird jedes Mal neu geladen, wenn eine neue Da-
tenproduktion durch die hergestellte Verbindung auftritt. Während der Timer läuft, unterdrückt
das Gerät neue Datenproduktion, bis der Timer abgelaufen ist. Diese Methode verhindert, dass
das Gerät zu schnell mit eingehenden Anfragen überlastet wird. Der Wert 0 definiert keine Sen-
desperrzeit und die Datenproduktion wird so schnell wie möglich durchgeführt. 
Die Expected Packet Rate, wird immer vor einer E/A Übertragung and das Gerät übermittelt. Der
Wert wird dann vom Gerät verwendet, um seinen Transmission Trigger Timer und Watchdog Ti-
mer zu zu laden.  Die Sendesperrzeit wird gegen die Expected Packet Rate überprüft. Wenn der
Wert der Expected Packet Rate ungleich 0 aber geringer als die Sendesperrzeit ist, führt dies zu
einer Fehlermledung.

Fragmentierungs Timeout / Aktion bei Zeitüberw.-Fehler

Wenn eine E/A Daten Übertragung oder eine Explicit Message größer als 8 Byte ist, muss diese
im DeviceNet fragmentiert (in mehreren einzelnen Telegrammen) übertragen werden. Der Frag-
mentierungs-Timeout legt fest, wie lange der Master wartet, bis ein Slave auf ein fragmentiertes
Telegramm antwortet. Tritt ein Zeitüberwachungsfehler auf, so steht ein automatisches Abbau-
en, Löschen und Zurücksetzen der Verbindung zur Verfügung.

Sind keine anderen Vorgaben bekannt, so können die Einstellungen für die Datenübertragung
wie im abgebildeten Screenshot übernommen werden.
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Verfügbare vordefinierte Verbindungsdatentypen

Der B&R Feldbus Konfigurator stellt Byte Arrays für Ein- als auch Ausgangsdaten zur Verfü-
gung. Die benötigten Längen (welche vom Slave produziert und konsumiert werden) können in
beliebiger Reihenfolge zusammengestellt werden. Die Anzahl der benötigten Ein- und Aus-
gangsdaten ergibt sich aus den vorgenommenen Parametrierungen.

Konfigurierte E/A-Verbindungsdaten und deren Offsetadressen

Im unteren Teil der Gerätekonfiguration werden alle ausgewählten Verbindungsdaten aufgelis-
tet. Benötigte Ein- und Ausgangsdatenlängen können in beliebiger Reihenfolge angeordnet wer-
den.

3.3.2  Parameter Daten

Die lineare Projektierung des DeviceNet Feldbusses mit dem B&R Feldbuskonfigurator setzt die
manuelle Konfiguration für jeden Netzteilnehmer voraus. Parametriert wird neben dem verwen-
deten B&R DeviceNet Bus Controller jeder Teilnehmer, der am X2X Netzwerk integriert ist. Ent-
scheidend ist hierbei, dass die vorgenommene Parametrierungsreihenfolge mit der tatsächlich
vorhanden physikalischen Reihenfolge übereinstimmen muss. Durch Klicken auf den Button
"Parameter Data" öffnet sich das Konfigurationsfenster.

Abbildung 46: Parameterfenster
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Bedeutung der Tabellensortierung:

Die Vorgehensweise der Konfiguration für die Bus Controller und die X2X-Link Module wird
nachfolgend erklärt. Ein ausführliches Beispiel anhand des X67BC5321 mit angehängtem digi-
talen Ausgangsmodul X67DO1332 soll den Parametrierungsvorgang Schritt für Schritt erklären.

X20BC0053 Parametrierung

Die Instance Nummer 1(Slot 1) beinhaltet die Konfiguration des  X20BC0053  Bus Controller so-
wie die des X20PS9400 als Einspeisemodul.

Parametrierung lokaler I/O Module am X20BC0053

Unten stehende Parameter stehen sowohl für das Slot 1 Modul (entweder X20PS9400 oder
X67DM1321) als auch für jedes weitere I/O Modul im X2X Link zur Verfügung.

Tabelleneintrag Bedeutung

Obj. Nummerierung der verschiedenen Parameter (0001 ....)

Class Entspricht der Modul Klasse, z. B. $64 für Bus Controller, $65 für X2X Link Module

Inst. Angabe der Inst. Nummer (Slotposition),
Inst. 1 (Slot 1) steht für Bus Controller inklusive des zugehörigen ersten Moduls

X20BC0053 (mit X20PS9400)
X67BC5321 (mit X67DM1321)

Attr. Attributnummer, Parameter spezifisch

Type Datentyp z. B. USINT, UINT

Access Lese-/Schreibzugriff

Parameter Name Parameterbezeichnung

Min vordefinierter Minimalwert

Max vordefinierter Maximalwert

Tabelle 4: Bedeutung der Tabellenspalten

Parameter Name Min Max Beschreibung

Buscontroller Extended Status $00 $06 Länge des erweiterten Bus Controller Status,
Wert zählt als Eingangs-Datenlänge

Missing Module ignore error Verhalten bei fehlendem Modul

Module Mismatch error ignore Verhalten wenn Modul nicht mit Konfiguration übereinstimmt

Tabelle 5: Parametrierungsoptionen X20 Bus Controller

Parameter Name Min Max Beschreibung

Slot1 Modul_Type $0000 $FFFF Modultyp

Slot1 Input Length $00 $FF Länge der Eingangsdaten

Slot1 Output Length $00 $FF Länge der Ausgangsdaten

Slot1 Parameter_1 $00000000 $FFFFFFFF Parametrierungsdaten

Slot1 Parameter_2 $00000000 $FFFFFFFF Parametrierungsdaten

Tabelle 6: Parametrierungsoptionen lokaler I/O Module
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Eine mögliche Konfiguration könnte für den X2BC0053 als Bus Controller und die X20PS9400
als I/O Modul auf Slot 1 wie folgt aussehen:

Beispiel Parametrierung X20BC0053

Beispiel Parametrierung X20PS9400

Slot1 Parameter_3 $00000000 $FFFFFFFF Parametrierungsdaten

Slot1 Parameter_4 $000000000 $FFFFFFFF Parametrierungsdaten

Parameter Name Wert Beschreibung

Buscontroller Extended Status 06 Für ein einfaches Testen der Verbindung kann dieser Wert auf 06, maxi-
male Übertragung aller möglichen Statusinformationen, belassen werden.
Byte 1 entspricht dem allgemeinen Status, Byte 2-6 ... jedes X2X Link Mo-
dul ist in diesen 5 Byte als Bit abgebildet 5 * 8 Bit = 40 Bit), falls ein kriti-
scher Fehler (Modul Missing, Modul Mismatch) an einem Modul auftritt, 

wird das jeweilige Bit dafür gesetzt.

Missing Module error Fehlendes Modul im X2X Link erzeugt kritischen Felhler (BC stopped)

Module Mismatch error Stimmt das projektierte Modul nicht mit dem tatsächlich physikalischen 
Modul überein erzeugt diesen einen kritischen Fehler (BC stopped)

Tabelle 7: Beispiel Parametrierung X20BC0053

Parameter Name Wert Beschreibung

Slot1 Modul_Type $1F8C B&R ID-Code des X20PS9400 Moduls. Wird vom Tool automatisch ge-
wählt, da erstes Modul bekannt ist.

Slot1 Input Length $01 Länge der benötigten Eingangsdaten für das X20PS9400 Modul.
Registerbelegungen der X20PS9400 befinden sich im X20 Anwender-

handbuch. Soll z. B. nur der Modulstatus abgefragt werden, wird hierfür 
ein Byte benötigt.

-> Erklärung zur Berechnung im Kapitel 5 in diesem Handbuch

Slot1 Output Length $00 Bei der X20PS9400 enstehen keine Ausgangsdaten.
-> Erklärung zur Berechnung im Kapitel 5 in diesem Handbuch

Slot1 Parameter_1 reserved bei der X20PS9400 keine Einstellungen zu treffen

Slot1 Parameter_2 reserved -“-

Slot1 Parameter_3 reserved -“-

Slot1 Parameter_4 reserved -“-

Tabelle 8: Parametrierung Slot 1 X20BC0053

Parameter Name Min Max Beschreibung

Tabelle 6: Parametrierungsoptionen lokaler I/O Module
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X67BC5321 Parametrierung

Die Instance Nummer 1(Slot 1) beinhaltet die Konfiguration des  X20BC5321  Bus Controller so-
wie die des digitalen Mischmoduls X67DM1321.

X67DM1321 Parametrierung

Beispiel Parametrierung X67BC5321

Beispiel Parametrierung X67DM 1321

Parameter Name Min Max Beschreibung

Buscontroller Extended Status $00 $06 Länge des erweiterten Bus Controller Status
Wert zählt als Eingangs-Datenlänge

Missing Module ignore error Verhalten bei fehlendem Modul

Module Mismatch error ignore Verhalten wenn Modul nicht mit Konfiguration übereinstimmt

Tabelle 9: Parametrierungsoptionen X67 Bus Controller

Parameter Name Min Max Beschreibung

Slot1 Modul_Type $0000 $FFFF Modultyp

Slot1 Input Length $00 $FF Länge der Eingangsdaten

Slot1 Output Length $00 $FF Länge der Ausgangsdaten

Slot1 IO_Mask $00 $FF Setzen der I/O Maske

Slot1 Input_Filter_Time $00 $FA Festlegung der Eingangsfilter

Slot1 Counter_1_Configuration $00 $FF Konfiguration Zählkanal 1

Slot1 Counter_2_Configuration $00 $FF Konfiguration Zählkanal 2

Tabelle 10: Beispiel Parametrierung X67BC5321

Parameter Name Wert Beschreibung

Buscontroller Extended Status $06 Für ein einfaches Testen der Verbindung kann dieser Wert auf 06, maxi-
male Übertragung aller möglichen Statusinformationen, belassen werden.
Byte 1 entspricht dem allgemeinen Status, Byte 2-6 ... jedes X2X Link Mo-
dul ist in diesen 5 Byte als Bit abgebildet 5 * 8 Bit = 40 Bit), falls ein kriti-
scher Fehler (Modul Missing, Modul Mismatch) an einem Modul auftritt, 

wird das jeweilige Bit dafür gesetzt

Missing Module error Fehlendes Modul im X2X Link erzeugt kritischen Fehler (BC stopped)

Module Mismatch error Stimmt das projektierte Modul nicht mit dem tatsächlich physikalischen 
Modul überein erzeugt diesen einen kritischen Fehler (BC stopped)

Tabelle 11: Beispielparametrierung X67BC5321

Parameter Name Wert Beschreibung

Slot1 Modul_Type $1311 B&R ID-Code des X67DM1321 Moduls. Wird vom Tool automatisch ge-
wählt, da erstes Modul bekannt ist.

Tabelle 12: Parametrierung Slot 1 X67BC5321
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Parameterdaten X2X-Link Modul (Slot 2 bis Slot 40)

Die Parametrierung der angehängten X2X-Link Teilnehmer ist für die X20 und X67-Module iden-
tisch und ermöglicht folgende Einstellungen. 

Die reservierten Parameterdaten erlauben eine spezifische Konfiguration aller X2X-Link Module.
Um den verschiedenen Eigenschaften gerecht zu werden und den Konfigurationsvorgang ein-
heitlich zu gestalten wird die Parametrierung der einzelnen Register kompakt in insgesamt
4 Byte verpackt. Die vorderen 2 Byte entsprechen dem Register, die hinteren zwei Byte für den
jeweiligen Konfigurationswert.

Beispiel: Setzen der I/O-Maske eines X67DM1321 Moduls. Kanal 1 und Kanal 5-8 sollen als
Ausgänge konfiguriert werden. Einstellungen hierzu müssen laut Datenblatt des X67DM1321 im
Register 16 vorgenommen werden (16  dez = $0010 hex). Da Kanal 1,5,6,7,8 (11110001 bin =
$00F1) als Ausgänge gesetzt werden sollen, muss $00F1 auf des Register 16 geschrieben wer-
den. Es ergibt sich als Summe der Wert $001000F1 für die Parametrierung. Dieser Wert kann
dann z. B. Slotx/Parameterdaten_1 zugewiesen werden.

Slot1 Input Length $12 Länge der benötigten Eingangsdaten für das X67DM1321 Modul.
Registerbelegungen des X67DM1321 befinden sich im entsprechenden 
Datenblatt. Soll z. B. der Ausgangsstatus abgefragt werden, werden 12 

Byte benötigt.
-> Erklärung zur Berechnung im Kapitel 4 in diesem Handbuch

Slot1 Output Length $02 Z. B. Setzen der I/O Maske benötigt 2 Byte.
-> Erklärung zur Berechnung im Kapitel 4 in diesem Handbuch

Slot1 IO_Mask $FF alle Digitalkanäle werden als Ausgang definiert

Parameter Name Min Max Beschreibung

Slotx/Modul_Type $0000 $FFFF Angabe des B&R ID-Codes

Slotx/Input_Length $00 $FF Konsumierte Eingangsdaten
X20 Module -> Erklärung Kapitel 4 in diesem Handbuch
X67 Module -> Erklärung Kapitel 5 in diesem Handbuch

Slotx/Output_Length $00 $FF Produzierte Ausgangsdaten
X20 Module -> Erklärung Kapitel 4 in diesem Handbuch
X67 Module -> Erklärung Kapitel 5 in diesem Handbuch

Slotx/Parameter_1 $00000000 $FFFFFFFF Parameterdaten

Slotx/Parameter_2 $00000000 $FFFFFFFF Parameterdaten

Slotx/Parameter_3 $00000000 $FFFFFFFF Parameterdaten

Slotx/Parameter_4 $00000000 $FFFFFFFF Parameterdaten

Slotx/Parameter_5 $00000000 $FFFFFFFF Paramterdaten

Tabelle 13: Parametrierungsoptionen X2X Link Module

Parameter Name Wert Beschreibung

Tabelle 12: Parametrierung Slot 1 X67BC5321
54 DeviceNet Getting Started Anwenderhandbuch V 1.00



B&R Feldbus Konfigurator • Erstellen einer DeviceNet Konfiguration

Ka
pi

te
l 3

B&
R

 F
el

db
us

 K
on

fig
ur

at
or
3.3.3  Beispiel Parametrierung

Für den X67BC5321 soll am X2X-Link neben dem im Bus Controller integrierten X67DM1321
ein X67DO1332 konfiguriert werden. Es ergeben sich folgende Parameterdaten:

• X67BC5321 (inklusive X67DM1321)
X67DM1321 alle Digitalkanäle aus Ausgänge gesetzt, Setzen der Ausgänge, Kein Rück-
lesen des Ausgangsstatus

• X67DO1332

Die gewählten Konfigurationswerte sind in die Tabelle der konfigurierten Parameter zu übertra-
gen. In Summe ergeben sich folgende Ein- und Ausgangsdatenlängen

Parameter Name Wert Beschreibung

Buscontroller Extended Status $06 Wird auf $06 belassen, Default Einstellung

Missing Module error Fehlendes Modul im X2X Link erzeugt kritischen Fehler (BC stopped)

Module Mismatch error Stimmt das projektierte Modul nicht mit dem tatsächlich physikalischen 
Modul überein erzeugt die einen kritischen Fehler (BC stopped)

Slot1 Modul_Type $1311 B&R ID-Code des X67DM1321 Moduls. Wird vom Tool automatisch ge-
wählt

Slot1 Input Length $03 Einlesen des "event counter 1" erfordert 3 Byte an Eingangs-Datenänge.
-> Erklärung zur Berechnung im Kapitel 4 in diesem Handbuch

Slot1 Output Length $01 Setzen der Ausgänge erfordert 1 Byte als Ausgangsdaten.
-> Erklärung zur Berechnung im Kapitel 4 in diesem Handbuch

Slot1 IO_Mask $FE alle Digitalkanäle, bis auf Kanal 1 (Eingang) werden als Ausgang definiert

Tabelle 14: Mögliche Parametrierung Slot 1 X67BC5321

Parameter Name Wert Beschreibung

Slot2/Modul_Type $1467 B&R ID-Code des X67DO1332

Slot2/Input_Length $01 Rücklesen des Ausgagnsstatus gewünscht, deshalb $01
-> Erklärung zur Berechnung im Kapitel 4 in diesem Handbuch

Slot2/Output_Length $01 Setzen der Ausgänge erfordert $01
X67 Module -> Erklärung Kapitel 5 in diesem Handbuch

SlotX/Parameter_X --- entfällt, da keine weitere Parametrierung möglich

Tabelle 15: Beispiel Parametrierung X67DO1332

Modul Input-Längen Output-Längen

X67BC5321 (inklusive X67DM1321) Bus Controller Extended Status $06
Input Länge X67DM1321 = $03

Setzen Ausgänge $01

X67DO1332 Status of the outputs erfordert Input Länge $01 Setzen der Ausgänge $01

SUMME (immer dezimal!) 10 2

Tabelle 16: Berechnungsbeispiel X67BC5321
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Die errechneten Ein- und Ausgangsdatenlängen sind im Fenster der Geräte Konfiguration im un-
teren Abschnitt der konsumierten E/A-Verbindungsdaten einzutragen und über die Online Ver-
bindung auf den Master zu übertragen.

4. Online Verbindung

Um die erstellte Konfiguration auf den DeviceNet Master zu laden ist eine Online Verbindung
notwendig. Zur Auswahl dieser und um den Download zu starten Menüpunkt Online->Download
auswählen. Es öffnet sich ein Fenster zur Schnittstellenauswahl.

In diesem Beispiel wird die serielle Schnittstelle verwendet. Hierzu ist "CIF Serial Driver" auszu-
wählen. Hinweise zu den Einstellungsmöglichkeiten finden sich in der Online Hilfe des B&R
Feldbus Konfigurators.

Abbildung 47: Ein- und Ausgangsdaten Konfiguration
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Je nach Auswahl der seriellen Schnittstelle am Programmiergerät (PC), kann diese über den
Button "Connect COM X" verbunden werden. Ist der Verbindungsversuch fehlgeschlagen wird
eine entsprechende Fehlernummer ausgegeben (Fehlercodierung siehe Online Hilfe).

Nur bei dem ausgegebenen Fehlerwert "0" kann die entsprechende Schnittstelle zur Kommuni-
kation verwendet werden. Nachfolgend abgebildet ist eine Verbindung zur COM 1 Schnittstelle.

An dem vergebenen Namen "DNM" ist erkennbar, dass es sich hierbei um eine Verbindung zum
DeviceNet Master handelt. 

4.1  Download der erstellten Konfiguration

Nach erfolgreichem Verbindungsaufbau über die serielle Schnittstelle, kann die Konfiguration
übertragen werden. Falls bereits ein Busdatenverkehr stattfindet, wird mit einer Meldung darauf
hingewiesen, dass für den angestrebten Download sowohl der Master als auch der Slave ge-
stoppt werden.

Abbildung 48: Schnittstellenauswahl

Abbildung 49: Auswahl COM Schnittstelle
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4.2  Ergebnis der Konfiguration

Wurde bei der Master Konfiguration als Anlaufverhalten nach der Systeminitialisierung "Auto-
matic release of the communication by the device" eingestellt, starten die DeviceNet Slaves (hier
die B&R DeviceNet Bus Controller), automatisch und sollten sich genauso wie der Master im
RUN Modus befinden. (Bedeutung der entsprechenden LEDs sind dem Datenblatt zu entneh-
men). 
Bei Auswahl des Anlaufverhaltens "Controlled release of the communication by the application
programm" wartet der Slave auf den Start durch das Anwenderprogramm. Dies ist an den An-
zeigen der Status LEDs erkennbar. Die Bus Controller melden Verbindungs-Timeout
(Statusanzeige1: MOD/grün-ein NET/rot-blinkend).Erst nach Initialisierung und Starten der Bus
Controller durch das Anwenderprogramm werden diese in den "RUN" Modus geschaltet.

4.3  Einfache Diagnose

Ein schnelles und einfaches Ansteuern der Modulausgänge ermöglicht die Netzwerkansicht. 

Achtung: dies ist nur möglich wenn als Datenübergabeverfahren " no consistence, uncont-
rolled" sowie "automatic release ot the communication by the device" als Parameter für die An-
wenderschnittstelle eingestellt ist (Masterkonfiguration).

Dies Netzwerkansicht ist über das Menü Window->Network View zu öffnen. In der linken Spalte
befindet sich die logische Netzwerkansicht, in der sich sowohl Master als auch die dazugehöri-
gen Slaves befinden.
In der Mitte ist die Variablen (Tag)  Liste angeordnet, rechts davon das I/O Watch Fenster. Durch
hinüberziehen der links ausgewählten Buselemente in dieses Fenster lassen sich Ein- und Aus-
gangsdaten überwachen und vorgegebene Werte zuweisen. Hierzu auf ein gewünschtes Ele-
ment mit der rechten Maustaste klicken und "Start" aufrufen. 

In einer tabellarischen Übersicht werden die parametrierten Ein- und Ausgangsdaten aufgelistet.
Beim X67BC5321 (X67DM1321) sind alle digitalen Kanäle bis auf Kanal 1 als Ausgang definiert.
Kanal 1 wird als Zähler verwendet. In der Summe der Eingangsdaten steht Kanal 1 für Input008,
welcher bereits 8 Zähl-Ereignise registriert hat. Zudem wurde beim X67BC5321(Output001) der
Ausgangskanal 3 (Value 05) aktiviert.
Beim X76DO1332 (Output002) ist der 5 Ausgangskanal (Value 10) gesetzt.

Abbildung 50: Netzwerkansicht
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Der Input Wert  Input007 (Value 04) des X67BC5321 gibt z. B. an, dass derzeit keine Eingangs-
spannung am Kanal 1 anliegt.

5. Projektierung im Automation Studio

Für eine Projektierung der DeviceNet Slaves im Automation Studio müssen diese von extern ein-
gebunden werden. Es ist nicht möglich sie in gewohnter Weise in den Hardwarebaum einzufü-
gen. Deshalb muss mit dem B&R Feldbus Konfigurator ein BR-Modul erzeugt werden, welches
die gesamte Netzwerkonfiguration beinhaltet. Dieses kann anschließend als "System Object"
eingefügt werden.

5.1  Voraussetzungen

Die Ansteuerung der B&R DeviceNet Bus Controller geschieht über die FB_Lib Library. Mit ihr
und den integrierten BR-Dateien ist es möglich die Bus Controller zu projektieren.

5.2  Kommunikationsprofil

Damit die DeviceNet Bus Controller vom Anwenderprogramm angesteuert werden können,
müssen im B&R Feldbus Konfigurator zum bisherigen Beispiel abweichende Einstellungen vor-
genommen werden. Bei der Masterkonfiguration ist auf das Kommunikationsprofil "Controlled
release of the communication by the application program" sowie auf das Daten Übergabeverfah-
ren "Buffered, host controlled" umzustellen. Alle anderen Einstellungen können übernommen
werden.

5.3  Erstellen eines BR-Moduls

Ist die gewünschte Konfiguration im B&R Feldbus Konfigurator zusammengestellt und sind alle
Module parametriert, kann über den Menüpunkt Tool->Generate DBM/BR-Modul ein BR-Modul
erstellt werden. Hierzu muss in der grafischen Ansicht der Master fokusiert sein. 

Abbildung 51: I/O Watch
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Das Erzeugen des BR-Moduls läuft im Hintergrund ab. Die erzeugten Dateien werden im Pro-
jektordner abgespeichert. Hierzu wird ein Unterordner mit der Bezeichnung des Masters im Pro-
jektorder der gesamten Konfiguration angelegt. Ein erstelltes BR-File trägt folgende
Namensgebung: "dnm_xxx.br". Wobei "xxx" für die jeweilige eingetragene Stationsnummer des
Masters steht. Neben der ".br"-Datei wird eine ".dnm“ sowie eine ".bak" File erstellt.

In der  Abbildung ist das Projekt mit dem Namen "testproject" gespeichert. Es beinhaltet die BR-
Dateien zum Master mit der Stationsnummer "000".

5.4  Einfügen des BR-Moduls

Erzeugte BR-Module können in ein geöffnetes Projekt im Automation Studio eingefügt werden.
Über den Menüpunkt Insert->New Object lässt sich ein "System Object" einfügen. Das ge-
wünschte BR-File kann über die Browse-Funktionalität ausgewählt und eingefügt werden.  Das
eingefügte BR-Modul befindet sich in der Liste der Datenobjekte. Ein mögliches Projekt könnte
folgendermaßen aussehen:

5.5  Projektierung der B&R DeviceNet Bus Controller

Die Bus Controller müssen vom Task aus explizit initialisiert, gestartet/gestoppt und projektiert
werden. Exemplarisch soll hierfür eine einfache Ansteuerung der Ausgänge beschrieben wer-
den. Eine ausführlichere Beschreibung aller verwendeter Funktionsblöcke befindet sich in der
Automation Studio Online Hilfe in der Kategorie "Libraries".

Abbildung 52: BR-Modul Ordner

Abbildung 53: Eingefügtes BR-Modul
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5.5.1  Initialisierung

Ablauf einer Modul-Initialisierung:

• FBInit

Beim Aufruf der Funktion wird das über "FBInit_0.Device" angegebene Modul initialisiert. In die-
sem Fall handelt es sich um den 3EX450.77-1 DeviceNet Master (SL3), mit der verwendeten De-
viceNet Schnittstelle (IF1).

• FBConfig

Der Parameter "FBConfig_0.DevIdent" gibt an, auf welches Modul ein Download erfolgen soll.
Die Daten werden von der Funktion "FBInit" geliefert. Der Zeiger "FBConfig_0.ConfModulName"
gibt den Namen des Konfigurationsmoduls an, das auf dieses Modul geladen werden soll. Hier
wurde das zuvor erstellte "dnm_000" der Konfiguration mit dem X67BC5321 (alle Kanäle als
Ausgänge deklariert" mit angeschlossener X67DO1332 ausgewählt.

Abbildung 54: Modul-Initialisierung
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5.5.2  I/O Datenverkehr

Als Beispielapplikation sollen die Ausgänge des projektierten X67BC5321(X67DM1321) und
des X67DO1332 angesteuert werden. Mittels einer Variable wird aufwärts gezählt und das Er-
gebnis an die digitalen Ausgänge angelegt. Bei einem Überlauf wird bei 0 begonnen. 

• FBStart

Der Parameter "FBStart_0.DevIdent" gibt an, welcher Master gestartet werden soll. Die Daten
werden von der Funktion FBInit zur Verfügung gestellt.

• FBio

Dieser Funktionsbaustein setzt auf das zuvor ausgewählte gepufferte, mastergesteuerte Kom-
munikationsprofil auf. Durch zyklisches Aufrufen des FUBs aus einer Taskklasse und dem kon-
figurierten Konfigurationsmode werden die I/O Daten gepuffert übertragen.
Der Parameter "FBio_0.DevIdent" gibt an, welches Modul die I/O Daten kopieren soll. Die Daten
werden von der Funktion FBInit geliefert. Der FUB kopiert die Ein- und Ausgangsdatenbereiche
zwischen dem DeviceNet Master und den angegebenen Puffern für den BusController. Erlaubte
Prozessdaten-Übergabeverfahren (einzustellen im B&R Feldbus Konfigurator) sind:

• Buffered, host controlled

• Bus synchronous, host controlled

Abbildung 55: Zyklischer Programmablauf
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5.6  Projekt auf die Steuerung übertragen

Nachdem das erstellte Projekt erfolgreich kompiliert wurde (Project->Build All) kann es auf die
Steuerung übertragen werden. (Project->Transfer to Target). Um die CPU zu starten, sollte an-
schließend ein Warmstart durchgeführt werden (Project->Services->WarmRestart).

Aufgrund des übertragenen Tasks sollten alle Ausgänge der beiden X67 Module angesteuert
werden. Sichtbar ist dies am Aufleuchten der entsprechenden LEDs.
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Kapitel 4 • X20 Registerbelegung

1. Berechnung der Ein- und Ausgangsdatenlängen    

Die im B&R Feldbus Konfigurator für die Parametrierung benötigten Ein- und Ausgangsdaten-
längen können für die X20 Module aus nachfolgenden Registerbeschreibungen entnommen
werden. Als Konsequenz der Linearität werden die Datenblöcke in einer Einheit übertragen. Es
ist nicht möglich diese Datenblöcke modular zusammenzusetzen. Ausschlaggebend für die Grö-
ße der Ein- und Ausgangsdaten ist immer die gewünschte Option mit den höchsten Werten.

Erläutert wird die Berechnung der Ein- und Ausgangsdatenlängen an folgendem Modul:

• X20DO9321

Register 
(dez)

Register 
(hex)

Read Write Description Datatype Input 
Length

Output 
Length

2 0x02 X Digital outputs 1 - 8 USINT 1

3 0x03 X Digital outputs 9 - 12 USINT 2

30 0x1E X Status of the outputs 1 - 8 USINT 1

31 0x1F X Status of the outputs 9 - 12 USINT 2

Tabelle 17: Register X20DO9321

Gewünschte Paramtrierung konsumierte Eingangs-Datenlänge produzierte Ausgangs-Datenlänge

Setzen der digitalen Ausgänge 1-8 sowie 
der Ausgänge 9 - 12

Setzen der digitalen Ausgänge 1-8 entspricht 
Ausgangsdatenlänge 1, setzen der digitalen Aus-
gänge 9-12 benötigt die Ausgangsdatenlänge 2,

entscheidend ist die höhere 
Ausgangsdatenlänge -> 2

Besteht nur Intereresse am Rücklesen der 
Statuswerte der Ausgänge 1-8, Rückle-

sen der Ausgänge 9-12 soll nicht durchge-
führt werden

Lesen des Ausgangstatus 1-8 benötigt 1 Byte 
Eingangslänge, Eingangs-Datenlänge ->1

Tabelle 18: Beispiel der Ein- und Ausgangsdatenlängen des X20DO9321
65DeviceNet Getting Started Anwenderhandbuch V 1.00



X20 Registerbelegung • Einspeisemodule
2. Einspeisemodule

2.1  X20BR9300

2.2  X20BT9100

2.3  X20PS2100

2.4  X20PS2110

Register 
(dez)

Register 
(hex)

Read Write Description Datatype Input 
Length

Output 
Length

0 0x00 X Supply status USINT 1

2 0x02 X Bus current (0,1 A) USINT 2

4 0x04 X Bus voltage USINT 3

Tabelle 19: Register X20BR9300

Register 
(dez)

Register 
(hex)

Read Write Description Datatype Input 
Length

Output 
Length

0 0x00 X Supply status USINT 1

2 0x02 X Bus current (0,1 A) USINT 2

4 0x04 X Bus voltage USINT 3

Tabelle 20: Register X20BT9100

Register 
(dez)

Register 
(hex)

Read Write Description Datatype Input 
Length

Output 
Length

0 0x00 X Supply status USINT 1

2 0x02 X Bus current (0,1 A) USINT 2

4 0x04 X Bus voltage USINT 3

Tabelle 21: Register X20PS2100

Register 
(dez)

Register 
(hex)

Read Write Description Datatype Input 
Length

Output 
Length

0 0x00 X Supply status USINT 1

2 0x02 X Bus current (0,1 A) USINT 2

4 0x04 X Bus voltage USINT 3

Tabelle 22: Register X20PS2110
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2.5  X20PS3300

2.6  X20PS3310

2.7  X20PS4951

2.8  X20PS9400

Register 
(dez)

Register 
(hex)

Read Write Description Datatype Input 
Length

Output 
Length

0 0x00 X Supply status USINT 1

2 0x02 X Bus current (0,1 A) USINT 2

4 0x04 X Bus voltage USINT 3

Tabelle 23: Register X20PS3300

Register 
(dez)

Register 
(hex)

Read Write Description Datatype Input 
Length

Output 
Length

0 0x00 X Supply status USINT 1

2 0x02 X Bus current (0,1 A) USINT 2

4 0x04 X Bus voltage USINT 3

Tabelle 24: Register X20PS3310

Register 
(dez)

Register 
(hex)

Read Write Description Datatype Input 
Length

Output 
Length

0 0x00 X Supply status USINT !

Tabelle 25: Register X20PS4951

Register 
(dez)

Register 
(hex)

Read Write Description Datatype Input 
Length

Output 
Length

0 0x00 X Supply status USINT 1

2 0x02 X Bus current (0,1 A) USINT 2

4 0x04 X Bus voltage USINT 3

Tabelle 26: Register X20PS9400
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3. Digitale Eingangsmodule

3.1  X20DI2371

3.2  X20DI2372

3.3  X20DI2377

3.4  X20DI4371

3.5  X20DI4372

Register 
(dez)

Register 
(hex)

Read Write Description Datatype Input 
Length

Output 
Length

0 0x00 X Digital inputs 1 - 2 USINT 1

18 0x12 X X Input filter USINT 2 1

Tabelle 27: Register X20DI2371

Register 
(dez)

Register 
(hex)

Read Write Description Datatype Input 
Length

Output 
Length

0 0x00 X Digital inputs 1 - 2 USINT 1

18 0x12 X X Input filter USINT 2 1

Tabelle 28: Register X20DI2372

Register 
(dez)

Register 
(hex)

Read Write Description Datatype Input 
Length

Output 
Length

4 0x04 X Event counter 1 UINT 2

6 0x06 X Event counter 2 UINT 4

Tabelle 29: Register X20DI2377

Register 
(dez)

Register 
(hex)

Read Write Description Datatype Input 
Length

Output 
Length

0 0x00 X Digital inputs 1 - 4 USINT 1

Tabelle 30: Register X20DI4371

Register 
(dez)

Register 
(hex)

Read Write Description Datatype Input 
Length

Output 
Length

0 0x00 X Digital inputs 1 - 4 USINT 1

Tabelle 31: Register X20DI4372
68 DeviceNet Getting Started Anwenderhandbuch V 1.00



X20 Registerbelegung • Digitale Eingangsmodule

Ka
pi

te
l 4

X2
0 

R
eg

is
te

rb
el

eg
un

g

3.6  X20DI4760

3.7  X20DI6371

3.8  X20DI6372

3.9  X20DI9371

3.10  X20DI9372

Register 
(dez)

Register 
(hex)

Read Write Description Datatype Input 
Length

Output 
Length

0 0x00 X Digital inputs 1 - 4 USINT 1

Tabelle 32: Register X20DI4760

Register 
(dez)

Register 
(hex)

Read Write Description Datatype Input 
Length

Output 
Length

0 0x00 X Digital inputs 1 - 6 USINT 1

Tabelle 33: Register X20DI6371

Register 
(dez)

Register 
(hex)

Read Write Description Datatype Input 
Length

Output 
Length

0 0x00 X Digital inputs 1 - 6 USINT 1

Tabelle 34: Register X20DI6372

Register 
(dez)

Register 
(hex)

Read Write Description Datatype Input 
Length

Output 
Length

0 0x00 X Digital inputs 1 - 8 USINT 1

1 0x01 X Digital inputs 9 - 12 USINT 2

Tabelle 35: Register X20DI9371

Register 
(dez)

Register 
(hex)

Read Write Description Datatype Input 
Length

Output 
Length

0 0x00 X Digital inputs 1 - 8 USINT 1

1 0x01 X Digital inputs 9 - 12 USINT 2

Tabelle 36: Register X20DI9372
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4. Digitale Ausgangsmodule

4.1  X20DO2321

4.2  X20DO2322

4.3  X20DO2649

4.4  X20DO4321

4.5  X20DO4322

Register 
(dez)

Register 
(hex)

Read Write Description Datatype Input 
Length

Output 
Length

2 0x02 X Digital outputs 1 - 2 USINT 1

30 0x1E X Status of the outputs 1 - 2 USINT 1

Tabelle 37: Register X20DO2321

Register 
(dez)

Register 
(hex)

Read Write Description Datatype Input 
Length

Output 
Length

2 0x02 X Digital outputs 1 - 2 USINT 1

30 0x1E X Status of the outputs 1 - 2 USINT 1

Tabelle 38: Register X20DO2322

Register 
(dez)

Register 
(hex)

Read Write Description Datatype Input 
Length

Output 
Length

2 0x02 X Digital outputs 1 - 2 USINT 1

Tabelle 39: Register X20DO2649

Register 
(dez)

Register 
(hex)

Read Write Description Datatype Input 
Length

Output 
Length

2 0x02 X Digital outputs 1 - 4 USINT 1

30 0x1E X Status of the outputs 1 - 4 USINT 1

Tabelle 40: Register X20DO4321

Register 
(dez)

Register 
(hex)

Read Write Description Datatype Input 
Length

Output 
Length

2 0x02 X Digital outputs 1 - 4 USINT 1

30 0x1E X Status of the outputs 1 - 4 USINT 1

Tabelle 41: Register X20DO4322
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4.6  X20DO4331

4.7  X20DO4332

4.8  X20DO4529

4.9  X20DO6321

4.10  X20DO6322

Register 
(dez)

Register 
(hex)

Read Write Description Datatype Input 
Length

Output 
Length

2 0x02 X Digital outputs 1 - 4 USINT 1

30 0x1E X Status of the outputs 1 - 4 USINT 1

Tabelle 42: Register X20DO4331

Register 
(dez)

Register 
(hex)

Read Write Description Datatype Input 
Length

Output 
Length

2 0x02 X Digital outputs 1 - 4 USINT 1

30 0x1E X Status of the outputs 1 - 4 USINT 1

Tabelle 43: Register X20DO4332

Register 
(dez)

Register 
(hex)

Read Write Description Datatype Input 
Length

Output 
Length

2 0x02 X Digital output 1 - 1 USINT 1

Tabelle 44: Register X20DO4529

Register 
(dez)

Register 
(hex)

Read Write Description Datatype Input 
Length

Output 
Length

2 0x02 X Digital outputs 1 - 6 USINT 1

30 0x1E X Status of the outputs 1 - 6 USINT 1

Tabelle 45: Register X20DO6321

Register 
(dez)

Register 
(hex)

Read Write Description Datatype Input 
Length

Output 
Length

2 0x02 X Digital outputs 1 - 6 USINT 1

30 0x1E X Status of the outputs 1 - 6 USINT 1

Tabelle 46: Register X20DO6322
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4.11  X20DO6529

4.12  X20DO8331

4.13  X20DO8332

4.14  X20DO9321

4.15  X20DO9322

Register 
(dez)

Register 
(hex)

Read Write Description Datatype Input 
Length

Output 
Length

2 0x02 X Digital output 1 - 6 USINT 1

Tabelle 47: Register X20DO6529

Register 
(dez)

Register 
(hex)

Read Write Description Datatype Input 
Length

Output 
Length

2 0x02 X Digital outputs 1 - 8 USINT 1

30 0x1E X Status of the outputs 1 - 8 USINT 1

Tabelle 48: Register X20DO8331

Register 
(dez)

Register 
(hex)

Read Write Description Datatype Input 
Length

Output 
Length

2 0x02 X Digital outputs 1 - 8 USINT 1

30 0x1E X Status of the outputs 1 - 8 USINT 1

Tabelle 49: Register X20DO8332

Register 
(dez)

Register 
(hex)

Read Write Description Datatype Input 
Length

Output 
Length

2 0x02 X Digital outputs 1 - 8 USINT 1

3 0x03 X Digital outputs 9 - 12 USINT 2

30 0x1E X Status of the outputs 1 - 8 USINT 1

31 0x1F X Status of the outputs 9 - 12 USINT 2

Tabelle 50: Register X20DO9321

Register 
(dez)

Register 
(hex)

Read Write Description Datatype Input 
Length

Output 
Length

2 0x02 X Digital outputs 1 - 8 USINT 1

3 0x03 X Digital outputs 9 - 12 USINT 2

30 0x1E X Status of the outputs 1 - 8 USINT 1

31 0x1F X Status of the outputs 9 - 12 USINT 2

Tabelle 51: Register X20DO9322
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5. Analoge Eingangsmodule

5.1  X20AI2622

5.2  X20AI2632

5.3  X20AI4622

5.4  X20AI4632

Register 
(dez)

Register 
(hex)

Read Write Description Datatype Input 
Length

Output 
Length

0 0x00 X Analog input 1 INT 2

2 0x02 X Analog input 2 INT 4

30 0x1E X Status analog inputs USINT 5

Tabelle 52: Register X67AI2622

Register 
(dez)

Register 
(hex)

Read Write Description Datatype Input 
Length

Output 
Length

0 0x00 X Analog input 1 INT 2

4 0x04 X Analog input 2 INT 4

Tabelle 53: Register X67AI2632

Register 
(dez)

Register 
(hex)

Read Write Description Datatype Input 
Length

Output 
Length

0 0x00 X Analog input 1 INT 2

2 0x02 X Analog input 2 INT 4

4 0x04 X Analog input 3 INT 6

6 0x06 X Analog input 4 INT 8

30 0x1E X Status analog inputs USINT 9

Tabelle 54: Register X67AI4622

Register 
(dez)

Register 
(hex)

Read Write Description Datatype Input 
Length

Output 
Length

0 0x00 X Analog input 1 INT 2

4 0x04 X Analog input 2 INT 4

8 0x08 X Analog input 3 INT 6

12 0x0C X Analog input 4 INT 8

Tabelle 55: Register X67AI4622
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6. Analoge Ausgangsmodule

6.1  X20AO2622

6.2  X20AO2632

6.3  X20AO4622

6.4  X20AO4632

Register 
(dez)

Register 
(hex)

Read Write Description Datatype Input 
Length

Output 
Length

0 0x00 X Analog output 1 INT 2

2 0x02 X Analog output 2 INT 4

18 0x12 X Channel type (FW ≥ V530 / V768) USINT 5

Tabelle 56: Register X20AO2622

Register 
(dez)

Register 
(hex)

Read Write Description Datatype Input 
Length

Output 
Length

0 0x00 X Analog output 1 INT 2

2 0x02 X Analog output 2 INT 4

Tabelle 57: Register X20AO2632

Register 
(dez)

Register 
(hex)

Read Write Description Datatype Input 
Length

Output 
Length

0 0x00 X Analog output 1 INT 2

2 0x02 X Analog output 2 INT 4

4 0x04 X Analog output 3 INT 6

6 0x06 X Analog output 4 INT 8

18 0x12 X Channel type (FW ≥ V530 / V768) USINT 9

Tabelle 58: Register X20AO4622

Register 
(dez)

Register 
(hex)

Read Write Description Datatype Input 
Length

Output 
Length

2 0x02 X Analog output 1 INT 2

4 0x04 X Analog output 2 INT 4

6 0x06 X Analog output 3 INT 6

8 0x08 X Analog output 4 INT 8

Tabelle 59: Register X20AO4632
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7. Temperaturmodule

7.1  X20AT2222

7.2  X20AT2402

7.3  X20AT4222

7.4  X20AT6402

Register 
(dez)

Register 
(hex)

Read Write Description Datatype Input 
Length

Output 
Length

0 0x00 X Analog input 1 (U)INT 2

2 0x02 X Analog input 2 (U)INT 4

30 0x1E X Status analog inputs USINT 5

Tabelle 60: Register X20AT2222

Register 
(dez)

Register 
(hex)

Read Write Description Datatype Input 
Length

Output 
Length

0 0x00 X Analog input 1 INT 2

2 0x02 X Analog input 2 INT 4

30 0x1E X Status analog inputs USINT 5

Tabelle 61: Register X20AT2402

Register 
(dez)

Register 
(hex)

Read Write Description Datatype Input 
Length

Output 
Length

0 0x00 X Analog input 1 (U)INT 2

2 0x02 X Analog input 2 (U)INT 4

4 0x04 X Analog input 3 (U)INT 6

6 0x06 X Analog input 4 (U)INT 8

30 0x1E X Status analog inputs USINT 9

Tabelle 62: Register X20AT2222

Register 
(dez)

Register 
(hex)

Read Write Description Datatype Input 
Length

Output 
Length

0 0x00 X Analog input 1 INT 2

2 0x02 X Analog input 2 INT 4

4 0x04 X Analog input 3 INT 6

6 0x06 X Analog input 4 INT 8

8 0x08 X Analog input 5 INT 10

Tabelle 63: Register X20AT2222
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10 0x0A X Analog input 6 INT 12

30 0x1E X Status analog inputs 1 - 4 USINT 13

31 0x1F X Status analog inputs 5 - 6 USINT 14

Register 
(dez)

Register 
(hex)

Read Write Description Datatype Input 
Length

Output 
Length

Tabelle 63: Register X20AT2222
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Kapitel 5 • X67 Registerbelegung

1. Berechnung der Ein- und Ausgangsdatenlängen

Die im B&R Feldbus Konfigurator für die Parametrierung benötigten Ein- und Ausgangsdaten-
längen können für die X67 Module aus nachfolgenden Registerbeschreibungen entnommen
werden. Als Konsequenz der Linearität werden die Datenblöcke in einer Einheit übertragen. Es
ist nicht möglich diese Datenblöcke modular zusammenzusetzen. Ausschlaggebend für die Grö-
ße der Ein- und Ausgangsdaten ist immer die gewünschte Option mit den höchsten Werten.

Erläutert wird die Berechnung der Ein- und Ausgangsdatenlängen an folgendem Modul:

• X67DM1321

Register 
(dez)

Register 
(hex)

Read Write Description Datatype Input 
Length

Output 
Length

0 0x00 X Digital inputs 1 - 8 USINT 1

2 0x02 X Digital outputs 1 - 8 USINT 1

4 0x04 X Event counter 1 UINT 3

6 0x06 X Event counter 2 UINT 5

16 0x10 X X I/O mask USINT 6 2

18 0x12 X X Input filter USINT 7 3

20 0x14 X X Configuration counter channel 1 USINT 8 4

22 0x16 X X Configuration counter channel 2 USINT 9 5

26 0x1A X Input latch - positive edge (FW ≥ V1.20) USINT 10

28 0x1C X X Acknowledgment-input latch (FW ≥ V1.20) USINT 11 6

30 0x1E X Status of the outputs USINT 12

Tabelle 64: Register X67DM1321

Gewünschte Paramtrierung konsumierte Eingangs-Datenlänge produzierte Ausgangs-Datenlänge

Verwendung des Ereigniszählers 1 Benötigte Eingangs-Datenlänge 3 Byte

Setzen der Digitalen Ausgänge 2-8, Beansprucht als Ausgangs-Datenlänge 1 Byte

Tabelle 65: Berechnungsbeispiel X67DM1321
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2. Einspeisemodul

Da das X67PS1300 Einspeisemodul über keinen I/O-Daten verfügt müssen keine Ein- und Aus-
gangsdatenlängen berechnet werden.

3. Digitale Eingangsmodule

3.1  X67DI1371

3.2  X67DI1371.L08 / X67DI1371.L12

4. Digitale Ausgangsmodule

4.1  X67DO1332

5. Digitale Mischmodule

5.1  X67DM1321

Register 
(dez)

Register 
(hex)

Read Write Description Datatype Input 
Length

Output 
Length

0 0x00 X Digital inputs 1 - 8 USINT 1

Tabelle 66: Register X67DI1371

Register 
(dez)

Register 
(hex)

Read Write Description Datatype Input 
Length

Output 
Length

0 0x00 X Digital inputs 1 - 8 USINT 1

1 0x01 X Digital inputs 9 - 16 USINT 2

Tabelle 67: Register X67DI1371.L08 / X67DI1371.L12

Register 
(dez)

Register 
(hex)

Read Write Description Datatype Input 
Length

Output 
Length

0 0x00 X Digital outputs 1 - 8 USINT 1

30 0x1E X Status of the outputs USINT 1

Tabelle 68: Register X67DO1332

Register 
(dez)

Register 
(hex)

Read Write Description Datatype Input 
Length

Output 
Length

0 0x00 X Digital inputs 1 - 8 USINT 1

2 0x02 X Digital outputs 1 - 8 USINT 1

Tabelle 69: Register X67DM1321
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5.2  X67DM1321.L08 / X67DM1321.L12

4 0x04 X Event counter 1 UINT 3

6 0x06 X Event counter 2 UINT 5

16 0x10 X X I/O mask USINT 6 2

18 0x12 X X Input filter USINT 7 3

20 0x14 X X Configuration counter channel 1 USINT 8 4

22 0x16 X X Configuration counter channel 2 USINT 9 5

26 0x1A X Input latch - positive edge (starting Version V1.20) USINT 10

28 0x1C X X Acknowledgment-input latch (starting V1.20) USINT 11 6

30 0x1E X Status of the outputs USINT 12

Register 
(dez)

Register 
(hex)

Read Write Description Datatype Input 
Length

Output 
Length

0 0x00 X Digital inputs 1 - 8 USINT 1

1 0x01 X Digital inputs 9 - 16 USINT 2

2 0x02 X Digital outputs 1 - 8 USINT 1

3 0x03 X Digital outputs 9 - 16 USINT 2

4 0x04 X Event counter 1 UINT 4

6 0x06 X Event counter 2 UINT 6

16 0x10 X X I/O masks 1 - 8 USINT 7 3

17 0x11 X X I/O masks 9 - 16 USINT 8 4

18 0x12 X X Input filter USINT 9 5

20 0x14 X X Configuration counter channel 1 USINT 10 6

22 0x16 X X Configuration counter channel 2 USINT 11 7

26 0x1A X Input latch - positive edge 1 - 8 USINT 12

27 0x1B X Input latch - positive edge 9 - 16 USINT 13

28 0x1C X X Acknowledgment - input latch 1 - 8 USINT 14 8

29 0x1D X X Acknowledgment - input latch 9 - 16 USINT 15 9

30 0x1E X Status of outputs 1 - 8 USINT 16

31 0x1F X Status of outputs 9 - 16 USINT 17

Tabelle 70: Register X67DM1321.L08 / X67DM1321.L12

Register 
(dez)

Register 
(hex)

Read Write Description Datatype Input 
Length

Output 
Length

Tabelle 69: Register X67DM1321
79DeviceNet Getting Started Anwenderhandbuch V 1.00



X67 Registerbelegung • Digitale Ventilsteuerungsmodule
5.3  X67DM9331.L12

6. Digitale Ventilsteuerungsmodule

6.1  X67DV1311.L08 / X67DV1311.L12

7. Analoge Eingangsmodule

7.1  X67AI1223

Register 
(dez)

Register 
(hex)

Read Write Description Datatype Input 
Length

Output 
Length

0 0x00 X Digital inputs USINT 1

2 0x02 X Digital outputs USINT 1

16 0x10 X X I/O  mask USINT 2 2

18 0x12 X X Input filter USINT 3 3

28 0x1C X Sensor/actuator supply status USINT 4

30 0x1E X Status of the outputs USINT 5

Tabelle 71: Register X67DM9331.L12

Register 
(dez)

Register 
(hex)

Read Write Description Datatype Input 
Length

Output 
Length

0 0x00 X Digital inputs 1 - 8 USINT 1

1 0x01 X Digital inputs 9 - 16 USINT 2

2 0x02 X Digital outputs 1 - 8 USINT 1

3 0x03 X Digital outputs 9 - 16 USINT 2

18 0x12 X X Input filter USINT 3 3

30 0x1E X Status of the outputs 1 - 8 USINT 4

31 0x1F X Status of outputs 9 - 16 USINT 5

Tabelle 72: Register X67DV1311.L08 / X67DV1311.L12

Register 
(dez)

Register 
(hex)

Read Write Description Datatype Input 
Length

Output 
Length

0 0x00 X Analog input 1 INT 2

2 0x02 X Analog input 2 INT 4

4 0x04 X Analog input 3 INT 6

6 0x06 X Analog input 4 INT 8

16 0x10 X X Filter parameters USINT 9 1

30 0x1E X Status - analog inputs USINT 10

Tabelle 73: Register X67AI1223
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7.2  X67AI1323

8. Analoge Ausgangsmodule

8.1  X67AO1223

8.2  X67AO1323

Register 
(dez)

Register 
(hex)

Read Write Description Datatype Input 
Length

Output 
Length

0 0x00 X Analog input 1 INT 2

2 0x02 X Analog input 2 INT 4

4 0x04 X Analog input 3 INT 6

6 0x06 X Analog input 4 INT 8

16 0x10 X X Filter parameters USINT 9 1

30 0x1E X Status - analog inputs USINT 10

Tabelle 74: Register X67AI1323

Register 
(dez)

Register 
(hex)

Read Write Description Datatype Input 
Length

Output 
Length

0 0x00 X Analog output 1 INT 2

2 0x02 X Analog output 2 INT 4

4 0x04 X Analog output 3 INT 6

6 0x06 X Analog output 4 INT 8

Tabelle 75: Register X67AO1223

Register 
(dez)

Register 
(hex)

Read Write Description Datatype Input 
Length

Output 
Length

0 0x00 X Analog output 1 INT 2

2 0x02 X Analog output 2 INT 4

4 0x04 X Analog output 3 INT 6

6 0x06 X Analog output 4 INT 8

Tabelle 76: RegisterX67AO1323
81DeviceNet Getting Started Anwenderhandbuch V 1.00



X67 Registerbelegung • Analoge Mischmodule
9. Analoge Mischmodule

9.1  X67AM1223

9.2  X67AM1323

10. Temperaturmodule

10.1  X67AT1322

Register 
(dez)

Register 
(hex)

Read Write Description Datatype Input 
Length

Output 
Length

0 0x00 X Analog input 1 INT 2

2 0x02 X Analog input 2 INT 4

8 0x08 X Analog output 1 INT 2

10 0x0A X Analog output 2 INT 4

16 0x10 X X Input filter parameter (starting with rev. ≥ Α7)  USINT 5 5

30 0x1E X Status - analog inputs USINT 6

Tabelle 77: RegisterX67AM1223

Register 
(dez)

Register 
(hex)

Read Write Description Datatype Input 
Length

Output 
Length

0 0x00 X Analog inputs 1 INT 2

2 0x02 X Analog input 2 INT 4

8 0x08 X Analog output 1 INT 2

10 0x0A X Analog output 2 INT 4

16 0x10 X X Input filter parameter (starting with rev. ≥ Β0) USINT 5 5

30 0x1E X Status - analog inputs USINT 6

Tabelle 78: Register X67AM1323

Register 
(dez)

Register 
(hex)

Read Write Description Datatype Input 
Length

Output 
Length

0 0x00 X Analog input 1 INT 2

2 0x02 X Analog input 2 q 4

4 0x04 X Analog input 3 INT 6

6 0x06 X Analog input 4 INT 8

16 0x10 X X Filter parameters USINT 9 1

18 0x12 X X Sensor type and channel selection UINT 11 3

30 0x1E X Status - analog inputs UINT 13

Tabelle 79: Register X67AT1322
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10.2  X67AT1402

Register 
(dez)

Register 
(hex)

Read Write Description Datatype Input 
Length

Output 
Length

0 0x00 X Analog input 1 INT 2

2 0x02 X Analog input 2 INT 4

4 0x04 X Analog input 3 INT 6

6 0x06 X Analog input 4 INT 8

8 0x08 X Terminal temperature 1 INT 10

10 0x0A X Terminal temperature 2 INT 12

12 0x0C X Terminal temperature 3 INT 14

14 0x0E X Terminal temperature 4 INT 16

16 0x10 X X Filter parameters USINT 17 1

18 0x12 X X Sensor type and channel selection USINT 18 2

30 0x1E X Status - analog inputs UINT 20

Tabelle 80: Register X67AT1402
83DeviceNet Getting Started Anwenderhandbuch V 1.00



X67 Registerbelegung • Temperaturmodule
84 DeviceNet Getting Started Anwenderhandbuch V 1.00



Ab
bi

ld
un

gs
ve

rz
ei

ch
ni

s

Abbildungsverzeichnis

Abbildungsverzeichnis
Abbildung 1: Menü im EDS-Wizard.....................................................................................  16
Abbildung 2: Auswahl der zu registrierenden EDS-Dateien................................................  17
Abbildung 3: Ergebnis der EDS-Datei Überprüfung............................................................  17
Abbildung 4: Parametrierung der seriellen Schnittstelle......................................................  18
Abbildung 5: Parametrierung der TCP/IP Schnittstelle .......................................................  19
Abbildung 6: Übersicht der konfigurierten Schnittstellen-Treiber ........................................  20
Abbildung 7: Browsing Funktion RSWho ............................................................................  20
Abbildung 8: Netzwerkkonfiguration....................................................................................  21
Abbildung 9: Baudraten-Einstellung....................................................................................  22
Abbildung 10: Knotennummern-Schalter X20BC0053..........................................................  23
Abbildung 11: Knotennummern-Schalter X67BC5321..........................................................  23
Abbildung 12: Parametrierung des X2X-Links am X20BC0053............................................  24
Abbildung 13: Konfiguration des X20BC0053 - I/O Summary...............................................  25
Abbildung 14: Parametrierung X20BC0053 ..........................................................................  26
Abbildung 15: Setzen der Ausgangs-Bytes...........................................................................  26
Abbildung 16: Scanliste des DeviceNet Masters...................................................................  27
Abbildung 17: Eingangsdaten im Master...............................................................................  28
Abbildung 18: ADR-Einstellungen.........................................................................................  29
Abbildung 19: Aktivierung der Schnittstelle ...........................................................................  30
Abbildung 20: Monitor Funktion.............................................................................................  31
Abbildung 21: Auswahl des CompactLogix Controller ..........................................................  32
Abbildung 22: Konfiguration CompactBus Local ...................................................................  33
Abbildung 23: RSLogix Projektfenster...................................................................................  33
Abbildung 24: Hardware-Verknüpfung ..................................................................................  34
Abbildung 25: Anlegen eines neuen Tasks...........................................................................  35
Abbildung 26: Anlegen einer neuen Variablen......................................................................  36
Abbildung 27: Verwendung einer Controller Variablen .........................................................  36
Abbildung 28: Monitor Controller Tags..................................................................................  37
Abbildung 29: OK-Button ......................................................................................................  37
Abbildung 30: Beispiel Programm.........................................................................................  37
Abbildung 31: MainRoutine ...................................................................................................  38
Abbildung 32: MSG-Funktionsbaustein.................................................................................  38
Abbildung 33: Explicit Messaging - Konfigurationsfenster ....................................................  39
Abbildung 34: Softwareseitiger Betriebsarten-Schalter.........................................................  39
Abbildung 35: EDS-Ordner....................................................................................................  42
Abbildung 36: Pfad der EDS-Dateien....................................................................................  42
Abbildung 37: Masterauswahl ...............................................................................................  43
Abbildung 38: Auswahl des DeviceNet Masters 3EX450.77-1..............................................  43
Abbildung 39: Mastereinstellungen .......................................................................................  44
Abbildung 40: Auswahl der Baudrate....................................................................................  45
Abbildung 41: Fenster zur Slave Auswahl.............................................................................  46
Abbildung 42: Knotennummern-Schalter X20BC0053..........................................................  46
Abbildung 43: Knotennummern-Schalter X67BC5321..........................................................  46
Abbildung 44: Master-Slave Beispielkonfiguration ................................................................  47
Abbildung 45: Slave Konfigurationsfenster X67BC5321.......................................................  48
Abbildung 46: Parameterfenster............................................................................................  50
Abbildung 47: Ein- und Ausgangsdaten Konfiguration..........................................................  56
85DeviceNet Getting Started Anwenderhandbuch V 1.00



Abbildungsverzeichnis
Abbildung 48: Schnittstellenauswahl.....................................................................................  57
Abbildung 49: Auswahl COM Schnittstelle ............................................................................  57
Abbildung 50: Netzwerkansicht .............................................................................................  58
Abbildung 51: I/O Watch .......................................................................................................  59
Abbildung 52: BR-Modul Ordner ...........................................................................................  60
Abbildung 53: Eingefügtes BR-Modul ...................................................................................  60
Abbildung 54: Modul-Initialisierung .......................................................................................  61
Abbildung 55: Zyklischer Programmablauf............................................................................  62
86 DeviceNet Getting Started Anwenderhandbuch V 1.00



Tabellenverzeichnis

Ta
be

lle
nv

er
ze

ic
hn

is

Tabellenverzeichnis
Tabelle 1: Handbuchhistorie ................................................................................................ 11
Tabelle 2: X20 DeviceNet Bus Controller ............................................................................ 12
Tabelle 3: X67 DeviceNet Bus Controller ............................................................................ 13
Tabelle 4: Bedeutung der Tabellenspalten .......................................................................... 51
Tabelle 5: Parametrierungsoptionen X20 Bus Controller..................................................... 51
Tabelle 6: Parametrierungsoptionen lokaler I/O Module...................................................... 51
Tabelle 7: Beispiel Parametrierung X20BC0053 ................................................................. 52
Tabelle 8: Parametrierung Slot 1 X20BC0053..................................................................... 52
Tabelle 9: Parametrierungsoptionen X67 Bus Controller..................................................... 53
Tabelle 10: Beispiel Parametrierung X67BC5321 ................................................................. 53
Tabelle 11: Beispielparametrierung X67BC5321................................................................... 53
Tabelle 12: Parametrierung Slot 1 X67BC5321..................................................................... 53
Tabelle 13: Parametrierungsoptionen X2X Link Module........................................................ 54
Tabelle 14: Mögliche Parametrierung Slot 1 X67BC5321 ..................................................... 55
Tabelle 15: Beispiel Parametrierung X67DO1332 ................................................................. 55
Tabelle 16: Berechnungsbeispiel X67BC5321 ...................................................................... 55
Tabelle 17: Register X20DO9321 .......................................................................................... 65
Tabelle 18: Beispiel der Ein- und Ausgangsdatenlängen des X20DO9321........................... 65
Tabelle 19: Register X20BR9300 .......................................................................................... 66
Tabelle 20: Register X20BT9100........................................................................................... 66
Tabelle 21: Register X20PS2100........................................................................................... 66
Tabelle 22: Register X20PS2110........................................................................................... 66
Tabelle 23: Register X20PS3300........................................................................................... 67
Tabelle 24: Register X20PS3310........................................................................................... 67
Tabelle 25: Register X20PS4951........................................................................................... 67
Tabelle 26: Register X20PS9400........................................................................................... 67
Tabelle 27: Register X20DI2371............................................................................................ 68
Tabelle 28: Register X20DI2372............................................................................................ 68
Tabelle 29: Register X20DI2377............................................................................................ 68
Tabelle 30: Register X20DI4371............................................................................................ 68
Tabelle 31: Register X20DI4372............................................................................................ 68
Tabelle 32: Register X20DI4760............................................................................................ 69
Tabelle 33: Register X20DI6371............................................................................................ 69
Tabelle 34: Register X20DI6372............................................................................................ 69
Tabelle 35: Register X20DI9371............................................................................................ 69
Tabelle 36: Register X20DI9372............................................................................................ 69
Tabelle 37: Register X20DO2321 .......................................................................................... 70
Tabelle 38: Register X20DO2322 .......................................................................................... 70
Tabelle 39: Register X20DO2649 .......................................................................................... 70
Tabelle 40: Register X20DO4321 .......................................................................................... 70
Tabelle 41: Register X20DO4322 .......................................................................................... 70
Tabelle 42: Register X20DO4331 .......................................................................................... 71
Tabelle 43: Register X20DO4332 .......................................................................................... 71
Tabelle 44: Register X20DO4529 .......................................................................................... 71
Tabelle 45: Register X20DO6321 .......................................................................................... 71
Tabelle 46: Register X20DO6322 .......................................................................................... 71
Tabelle 47: Register X20DO6529 .......................................................................................... 72
87DeviceNet Getting Started Anwenderhandbuch V 1.00



Tabellenverzeichnis
Tabelle 48: Register X20DO8331 .......................................................................................... 72
Tabelle 49: Register X20DO8332 .......................................................................................... 72
Tabelle 50: Register X20DO9321 .......................................................................................... 72
Tabelle 51: Register X20DO9322 .......................................................................................... 72
Tabelle 52: Register X67AI2622 ............................................................................................ 73
Tabelle 53: Register X67AI2632 ............................................................................................ 73
Tabelle 54: Register X67AI4622 ............................................................................................ 73
Tabelle 55: Register X67AI4622 ............................................................................................ 73
Tabelle 56: Register X20AO2622 .......................................................................................... 74
Tabelle 57: Register X20AO2632 .......................................................................................... 74
Tabelle 58: Register X20AO4622 .......................................................................................... 74
Tabelle 59: Register X20AO4632 .......................................................................................... 74
Tabelle 60: Register X20AT2222........................................................................................... 75
Tabelle 61: Register X20AT2402........................................................................................... 75
Tabelle 62: Register X20AT2222........................................................................................... 75
Tabelle 63: Register X20AT2222........................................................................................... 75
Tabelle 64: Register X67DM1321.......................................................................................... 77
Tabelle 65: Berechnungsbeispiel X67DM1321...................................................................... 77
Tabelle 66: Register X67DI1371............................................................................................ 78
Tabelle 67: Register X67DI1371.L08 / X67DI1371.L12......................................................... 78
Tabelle 68: Register X67DO1332 .......................................................................................... 78
Tabelle 69: Register X67DM1321.......................................................................................... 78
Tabelle 70: Register X67DM1321.L08 / X67DM1321.L12..................................................... 79
Tabelle 71: Register X67DM9331.L12................................................................................... 80
Tabelle 72: Register X67DV1311.L08 / X67DV1311.L12 ...................................................... 80
Tabelle 73: Register X67AI1223 ............................................................................................ 80
Tabelle 74: Register X67AI1323 ............................................................................................ 81
Tabelle 75: Register X67AO1223 .......................................................................................... 81
Tabelle 76: RegisterX67AO1323 ........................................................................................... 81
Tabelle 77: RegisterX67AM1223 ........................................................................................... 82
Tabelle 78: Register X67AM1323 .......................................................................................... 82
Tabelle 79: Register X67AT1322........................................................................................... 82
Tabelle 80: Register X67AT1402........................................................................................... 83
88 DeviceNet Getting Started Anwenderhandbuch V 1.00



Stichwortverzeichnis

St
ic

hw
or

tv
er

ze
ic

hn
is

Stichwortverzeichnis
B

B&R Feldbus Konfigurator .........................41

E

EDS-Datei ..................................................13
Ein- und Ausgangsdatenlängen .................14

H

Handbuchhistorie .......................................11

K

Knotennummern-Schalter .................... 23, 46

R

Rockwell Softwarepakete .......................... 15
RSLinx Classic .......................................... 15
RSLogix 5000 ............................................ 15
RSNetWorx for DeviceNet ......................... 15

X

X20 DeviceNet Bus Controlle .................... 12
X20 Register Anwenderhandbuch ............. 14
X67 DeviceNet Bus Controller ................... 12
89DeviceNet Getting Started Anwenderhandbuch V 1.00



Stichwortverzeichnis
90 DeviceNet Getting Started Anwenderhandbuch V 1.00



Be
st

el
ln

um
m

er
ni

nd
ex

Bestellnummernindex

Bestellnummernindex
91DeviceNet Getting Started Anwenderhandbuch V 1.00



Bestellnummernindex
92 DeviceNet Getting Started Anwenderhandbuch V 1.00


	MADNGETST-GER
	Inhaltsverzeichnis
	Kapitel 1 . Allgemeines
	1. Handbuchhistorie
	2. Integration der B&R DeviceNet Bus Controller
	2.1 X20 DeviceNet Bus Controller
	2.2 X67 DeviceNet Bus Controller

	3. EDS-Datei
	4. Unterschied lineare und modulare Projektierung
	4.1 Lineare Projektierung
	4.2 Modulare Projektierung

	5. X20 Register Anwenderhandbuch
	6. Berechnung der Ein- und Ausgangsdatenlängen

	Kapitel 2 . Rockwell Software
	1. Rockwell Softwarepakete
	1.1 RSLinx
	1.2 RSNetWorx for DeviceNet
	1.3 RSLogix 5000

	2. Hardware Voraussetzungen
	3. Installation der EDS-Datei
	4. Integration der B&R DeviceNet Bus Controller
	4.1 Online Verbindung
	4.2 Netzwerkkonfiguration
	4.3 Busparameter
	4.4 Parametrierung der B&R DeviceNet Bus Controller
	4.4.1 Parametrierung der einzelnen Slots

	4.5 Parametierung des DeviceNet Masters
	4.6 Download der erstellten Konfiguration
	4.7 Online-Diagnose

	5. Projektierung mit RSLogix 5000
	5.1 Auswahl des Controllers und der Online Verbindung
	5.2 Zuordnung der Hardwarekonfiguration
	5.3 Erstellung eines Tasks
	5.4 Download des Projekts auf die Steuerung


	Kapitel 3 . B&R Feldbus Konfigurator
	1. Einleitung
	2. Installation der EDS-Datei
	2.1 Bedienoberfläche
	2.2 Ordnerstruktur

	3. Erstellen einer DeviceNet Konfiguration
	3.1 Einfügen eines Masters
	3.1.1 Masterkonfiguration

	3.2 Busparameter
	3.3 Einfügen eines Slaves
	3.3.1 Slavekonfiguration
	3.3.2 Parameter Daten
	3.3.3 Beispiel Parametrierung


	4. Online Verbindung
	4.1 Download der erstellten Konfiguration
	4.2 Ergebnis der Konfiguration
	4.3 Einfache Diagnose

	5. Projektierung im Automation Studio
	5.1 Voraussetzungen
	5.2 Kommunikationsprofil
	5.3 Erstellen eines BR-Moduls
	5.4 Einfügen des BR-Moduls
	5.5 Projektierung der B&R DeviceNet Bus Controller
	5.5.1 Initialisierung
	5.5.2 I/O Datenverkehr

	5.6 Projekt auf die Steuerung übertragen


	Kapitel 4 . X20 Registerbelegung
	1. Berechnung der Ein- und Ausgangsdatenlängen
	2. Einspeisemodule
	2.1 X20BR9300
	2.2 X20BT9100
	2.3 X20PS2100
	2.4 X20PS2110
	2.5 X20PS3300
	2.6 X20PS3310
	2.7 X20PS4951
	2.8 X20PS9400

	3. Digitale Eingangsmodule
	3.1 X20DI2371
	3.2 X20DI2372
	3.3 X20DI2377
	3.4 X20DI4371
	3.5 X20DI4372
	3.6 X20DI4760
	3.7 X20DI6371
	3.8 X20DI6372
	3.9 X20DI9371
	3.10 X20DI9372

	4. Digitale Ausgangsmodule
	4.1 X20DO2321
	4.2 X20DO2322
	4.3 X20DO2649
	4.4 X20DO4321
	4.5 X20DO4322
	4.6 X20DO4331
	4.7 X20DO4332
	4.8 X20DO4529
	4.9 X20DO6321
	4.10 X20DO6322
	4.11 X20DO6529
	4.12 X20DO8331
	4.13 X20DO8332
	4.14 X20DO9321
	4.15 X20DO9322

	5. Analoge Eingangsmodule
	5.1 X20AI2622
	5.2 X20AI2632
	5.3 X20AI4622
	5.4 X20AI4632

	6. Analoge Ausgangsmodule
	6.1 X20AO2622
	6.2 X20AO2632
	6.3 X20AO4622
	6.4 X20AO4632

	7. Temperaturmodule
	7.1 X20AT2222
	7.2 X20AT2402
	7.3 X20AT4222
	7.4 X20AT6402


	Kapitel 5 . X67 Registerbelegung
	1. Berechnung der Ein- und Ausgangsdatenlängen
	2. Einspeisemodul
	3. Digitale Eingangsmodule
	3.1 X67DI1371
	3.2 X67DI1371.L08 / X67DI1371.L12

	4. Digitale Ausgangsmodule
	4.1 X67DO1332

	5. Digitale Mischmodule
	5.1 X67DM1321
	5.2 X67DM1321.L08 / X67DM1321.L12
	5.3 X67DM9331.L12

	6. Digitale Ventilsteuerungsmodule
	6.1 X67DV1311.L08 / X67DV1311.L12

	7. Analoge Eingangsmodule
	7.1 X67AI1223
	7.2 X67AI1323

	8. Analoge Ausgangsmodule
	8.1 X67AO1223
	8.2 X67AO1323

	9. Analoge Mischmodule
	9.1 X67AM1223
	9.2 X67AM1323

	10. Temperaturmodule
	10.1 X67AT1322
	10.2 X67AT1402


	Abbildungsverzeichnis
	Tabellenverzeichnis
	Stichwortverzeichnis
	Bestellnummernindex


